Operations Manual

SDS Data Logger

MODEL SDS 8020/8040

Universal Data Logger

Please read, understand, and follow these instructions before operating this equipment.

Super Systems, Inc. is not responsible for damages incurred due to a failure to comply with these
instructions. If at any time there are questions regarding the proper use of this data logger, please
contact us at (800) 666-4330 for assistance.

7205 Edington Drive

Cincinnati, OH 45249
513-772-0060 / 800-666-4330
Fax: 513-772-9466

WWW.supersystems.com
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Product Overview

Product Description

You'll find all the necessary information related to how to use the product in this manual. The product is
broken up into 2 parts, the software and hardware components. This user guide is also written in this
manor.

SDS8020 / SDS8040 provides the hardware and software needed to meet industry standards for
thermocouple uniformity by logging and generating temperature and data log reports.

It is easy to use and addresses the many industrial applications where datalogging, trending, and
reporting is required. The product is available in either the 20 or 40-channel version with user-defined
inputs for each channel.

The easy to use Survey Template and Report Manager provides users with all the necessary tools to
generate uniformity reports. The Report Manager includes a report writer that allows the user to setup
reports to meet their specific requirements. The Template Manager allows survey specific data to be
created, updated and used during the reporting process. All reports can be printed, saved electronically
and emailed using the software utilities. The SDS software tools along with the data logger, combine to
create a powerful solution for data logging and reporting temperature uniformity surveys.

Product Specifications

User defined “logging” intervals as frequently as 10 seconds
e Isolated inputs

e AC (90— 240 V) and DC Power

e Rechargeable battery — Approximately 12 hours of “runtime”
e Dimensions: 16”"D X 20"L X 8"H

e Password protected menu options

e Easy calibration

e Web-page enabled real-time view

e ETHERNET and RS232 serial communications

e 16-Bit A/D converter

e 128 Mbytes of on-board data

Super Systems Inc. Page 5 SDS Data Logger Manual #4565 Rev D



Degrees F. A/D Accuracy Accuracy Accuracy

At 1600 Degrees F with

TC Type Min Max Full scale Full Scale At 1600 Degrees F. thermister error
B 32 3308 0.0124% 0.0179% 0.29 0.65
C 32 4208 0.0062% 0.0067% 0.11 0.47
E -328 1832 0.0031% 0.0032% 0.05 0.41
J -346 2192 0.0031% 0.0036% 0.06 0.42
K -328 2502 0.0031% 0.0045% 0.07 0.43
N -328 2372 0.0031% 0.0052% 0.08 0.44

NNM 0 1409 0.0031% 0.0033% 0.05 0.41
R -58 3214 0.0062% 0.0118% 0.19 0.66
S -58 3214 0.0124% 0.0133% 0.21 0.57
T -328 752 0.0062% 0.0119% 0.19 0.55

*** Note: Accuracy at 1600 Degrees F with thermister error requires SDS firmware level 1.10 or later ***
Software Installation

You will find the SDS Recorder software CD that ships with the unit includes all the reporting and
administrative utilities. Insert the CD into the CD ROM device on your computer and click the setup.exe
file. You will be given a step-by-step instruction for completing the installation process. See Installing the
SDS Software section for more details.

Calibration

The SDS data logger is calibrated prior to shipment. The
calibration process is available through menu option 22 on the
data logger. Instructions for calibration are included in this
manual. Super Systems calibrates the SDS data logger using
NIST traceable instruments that are listed on the calibration
certificate included with the device. The default calibration is
performed using a zero and span routine for the millivolt range of
0 — 80mV. Each range that is being used should be calibrated.
For a list of suggested mV ranges by thermocouple types, please
refer to the section on Input Calibration in the manual. Other
calibration ranges are available upon request. 4

An input device will be used to input a specific type K
thermocouple value and the data logger value will be recorded.
This will be performed at different temperatures and printed with the certificate.
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Getting Started

When logging data, the operator will use the on-board display to start and stop the data logging / survey
process. The first steps related to data logging are connecting the inputs to the terminal strips on the
data logger. Each terminal strip represents a single analog board with 5 inputs. You can remove these
terminal strips by pulling up on both ends of the terminal strip.

Depending on the model number, you have either 20 or 40 input channels for data logging. For each
channel there will be a positive and negative connection which must be attached to the appropriate input.

The operator defines an input type for each channel. This is performed through menu option 8 (Modlify
Input Settings) on the data logger.

Once the inputs have been connected, the operator —*:  SELECT INPUT CHAMMELS
selects which inputs will be included in the survey.
This is done in 2 ways. The template provides

. . . ————>B1. 49.97 YES
operators with input selection but can be updated on g2 43137 ES
the data logger using the Select Input Channel option. A §£ $E§
When a template has been selected, the input Default

BE—Feb—202% Mon @3:44: 15AM

channels setup for the template, as defined in the
Template Manager, will be the selected channels for
the survey. As mentioned, this can be updated using menu option 7 Select Input Channel. Always
select a template prior to running a survey. If you want to create new templates, please see
section SDS Template Manager.

Analog Inputs

The Super Systems, Inc. 31541 Analog Board contains a group of five channels isolated from the main
DC power source. The board can be connected to thermocouples, voltage sources from 20mV full scale to
1.28 Volts full scale, or 4 — 20 mA current loops.

Thermocouple connections

Thermocouple wires can be connected directly to the terminal blocks. The thermocouple junctions should
not be grounded. If they do touch a ground reference, all thermocouples on a board must have a
common ground reference. If multiple thermocouples are connected to different ground reference points,
the accuracy of all thermocouples on the board cannot be guaranteed to be accurate.

Voltage connections

Voltages from 0 mV to 1.28 Volts can be directly connected to the terminal blocks. When measuring
ground-referenced voltages, all references must share a common ground reference. If the voltage
sources are connected to different ground reference points, the accuracy of all the voltage sources
connected to the board need to be checked for accuracy.

4 — 20 mA. Current Loop connections

Before connecting the current loop, insert the shorting jumper on the board for each channel used to
measure current loops. This jumper inserts the 62-ohm shunt resistor across the input of the A/D. If
multiple current loops are connected to one board, all must share the same power supply and ground
reference points or the accuracy of all the current loops need to be checked for accuracy.
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Survey Templates

The data logger will default to the last survey template used. To modify the template being used, the

1a= SELECT SURvE¥ TEMPLATE
Entry 1 o 4

operator can go to the Select Survey Template menu

option. This data will be carried over for the reporting
process to make the reporting quick and easy. On the
Survey Template screen there are parameters that can

TemklateI

Temelated
Default

be modified for a specific survey such as setpoint.

After setting the required parameters, the start survey
process can be selected. This will timestamp the

selection and the data logger will log all channels that have been selected for logging.

The operator may receive deviation alarms depending on the
current input and setpoint as well as the alarm settings. The
alarm will notify the operator when an input is outside the
plus/minus tolerance for the setpoint. The alarm information
will display on the data logger and show the number of
channels above tolerance and below the tolerance. The
survey continues to run, it is simply providing the operator
with the information on the display.

The operator can view the input channel data on a number of
different screens. The overview display will display all
channels on the device but by using the circular arrow key,
4y, the operator views the overview display with only the
“selected” input channels. By pressing the circular arrow key
again, the operator will get the Quick Chart View screen
displaying trend data for a specific channel.

At anytime, the operator can view the data in real-time from
the computer using the SDS Recorder software. The real-time

EeTauIE =
551 *~ = scroll
Batch 3
Action (8 = stoP. 1 = start)?
Suruved TemPerature Setpoint: -
To edit surved wvalues Press *Enter?

Started at:
Storred st
TemPl Name lefaull
Comtand MHams S1
Furnage 1D EBatch 3
Make = Model MWilliams

Furnace Tdke Batch Gas Draw
B&—Feb-208¢% Mon ©2:44:15AM

505 s02ena s

=
Plassh uinie 55 smcons

data option when selected displays the data every 10 seconds. The system will update 10-second
intervals every minute. Follow instructions for connecting the datalogger to the PC.

The survey can be stopped from the Display Survey Information
screen. On the Action option, entering a “0” and pressing the
Enter key will stop the survey.

After stopping the survey, other surveys can be taken by
repeating the above steps. At anytime, all survey data can be
downloaded to the PC using the Download Surveys And Data
option on SDS Recorder. Follow instructions for

1=Tk )

E_éTauIE -~
S581 *7 = scroll
Batch 3

Agtion (8 = stoP. 1 = starta:
surued Temeerature SetrPoint: -
To edit surved wvalues Press *Enter’

TemPl Nams
Comtand Mams
Furnace IT = -
Make % Model Williams
Furnace Tukre Batch Gas Draw

BE~Feb-280% Mon B3:44:15AM

Ba 5 ek

connecting the datalogger to the PC. AETETE

Ragert rogaras | char | outn |

=lgl )

Once the data has been downloaded, it is available e
for reporting. By clicking on the file open menu
option, the operator will be given the Report dialog
to generate a survey report. Reports use logged
data and the user specified interval in the report.
The report template selected will form the final

Petnt | Fuanace | ey baramoars | fureey Sucad | Thasmocousins | Contrater | Summrs o | Lser el |

O — |
R I

report view with all the template data, survey data

EDiEFirgenter - Fnsek

and additional report parameters that are entered.
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The report templates are user defined and should be configured to meet your needs. All reports can be
saved and displayed at a later date.
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Installation

Installing the SDS Software

Note — The person installing the SDS Software must have administrative rights on the
computer(s) where the installation is taking place for the installation to be successful.

Double-click on the setup file, SDSSetup.msi to start the auto-installation. If there is no version of the
SDS Reporter running on the computer, the installation will prompt the user for the download location
(figure 1.1).

iz SD'S Reporter

Select Installation Folder

The installer will install S0S Reporter to the following folder.

T o install in this folder. click “'Hest". To install to a different folder. enter it below or click "Brovese'.

Ealder:
[E~SSThsD5EN . |

Disk Cost... |

Install S0S Reporter For pourself. or for anvone who uses this computer:

" Eweryone
= Jdust me

Figure 1.1 SDS Reporter setup screen

The default location is “C:\SSI\SDS". Click on the “"Browse"” button to select an alternate location.
Clicking on the “Disk Cost...” button will display the available computer drives onto which the SDS
Reporter can be downloaded, as well as the total space, available space, and required space for each
drive. Selecting the “Everyone” option will install the SDS Reporter for all users on the computer, while
selecting the “Just me” option will only install the SDSReporter for the current user. Clicking on the
“Cancel” button will prompt the user to confirm exiting the setup without continuing. Clicking on the “<
Back” button will display the previous screen, which is the introduction screen for the installer. Clicking
the “Next >" button will continue with the installation process (figure 1.2).

iz SDS Reporter

Confirm Installation

The installer is ready to install 505 Reporter on your computer.

Click "'Mext' to start the installation.

Cancel < Back | £
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Figure 1.2 Installation ready screen

Clicking on the “Cancel” button will prompt the user to confirm exiting the setup without continuing.
Clicking on the “< Back” button will display the previous page, which is the installation setup page (figure
1.1). Clicking on the “Next >" button will install the software to the specified location. Once the
software has been installed, the installer can be closed. The SDS Reporter software will now be ready to
use.

If there is a version of the SDS Reporter already installed on the computer, the installer will either re-
install the software (Repair SDS Reporter option) or remove the software from the computer (Remove
SDS Reporter option) (figure 1.3). Clicking on the “Finish” button will proceed with the selected action.
Note: the installer does not remove any subfolders in the main SDS folder. These files will have to be
manually removed.

i-él SDS Reporter

Welcome to the SDS Reporter Setup Wizard

Select wahether vou want ta repair or remowe S0S FRepaorter

i+ Bepair 505 Reporter
= Remowve S05 Reporter

Figure 1.3 Repair/Remove SDS Reporter screen
Connecting The SDS Data Logger To A Network

Every SDS Data Logger shipped includes an Ethernet crossover
cable that will connect the data logger to a network. Once the
data logger is connected to a network, the SDS Reporter software
will be able to find it during any searches.

Connecting the data logger to your network or directly to
a PC is accomplished using the Ethernet port on your data logger. Ethernet Port

If you are connecting the data logger to your network, you will need an Ethernet
cable (the cable provided is a crossover cable for direct connections to a PC). The H
cable is plugged into the data logger Ethernet plug and then other end should be ==,
plugged into a network hub. If the IP Address of the data logger needs to be

changed, this can be done on the data logger through the Set IP Address menu
option.

If you are not putting the data logger on the network, you should use the Ethernet crossover cable that
has been provided with the device. Ethernet crossover cables are most often used when connecting two
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Ethernet computers without a hub. An Ethernet crossover cable has it's send and receive wires crossed.
When using a hub or switch, this is automatically done for you.

With a crossover cable, you are forming a network between the computer that you are directly plugged
into and the data logger. There will be some network settings on the computer that you will have to
configure for the 2 devices to communicate. The data logger will have the network setting already setup
with the following IP address — 192.168.1.215. This can be modified through the Set IP Address screen
on the data logger.

Network settings can be found through the Coniro/ Panel/in Microsoft Windows. By selecting Network

Setting, the operator will be

given a list of the current
ava"able Connection types 1) ywireless Metwark Connection LAM or High-Speed Inter...  Connected Dell Wireless 1370 WLAR. ..

| LANor High-Speed Internet

B8 ocal Area Connection LAM or High-Speed Inter..,  Metwork cable unplugged EBroadcom Metktreme 57,..

Using the crossover cable will_% | cicatie
require the Local Area u

Connection as seen in the beIOW Wirtual Private Netwark, Connected WaN Miniport (PPTP)
diagram to be modified. The Bridge Connections

Properties can be changed by Craate Shortcut

highlighting the connection and Rename

using the right mouse button to .

click and select the Properties tab

or by highlighting the connection and clicking on Change setting of this

ConneCtIOI’l . - Local Area Connection Properties
General | Authentication | Advanced
Once the Local Area Connection Properties screen is displayed, the Corest using
Internet Protocol (TCP/IP) tab should be highlighted. Click the - A A
Properties button to display Internet Protocol This cornection uses the followng ferms
= P TS oy n dvace d Networks
(TCP/ IP) Propertles. Internet Protocol (TCP/IP) Properties 33 ar:n; lor';rlicrosoftNetworks
- : (EE B02.1%]v2.20.3
i eneral
On the Internet PrOtOCOl (TCP/IP) PI’OpeI’tIeS tab, ‘t;uu ©an ETE IFUs‘itl\ngs assigned ?:Iutlomagca\ly if y?ur nftv‘\;olk slt.lp‘porlfs
. ; is capability. Otherwise, you need to ask your network administrator for
you will need to select the option for Use The e St F i
Following IP Address. Enter in the following data © btan anlP eddres avtomeicaly acalfltemet Potocol. The defaul
. (@) Uge the following IP address: 2ol that provides communication
On these flelds. 1P address: 132 168 . 1 . 203 i
Subnet mask: ~ 250,285 .28 . 0 | area when ‘?Dm"ec‘e‘j .
I P Ad d ress : 1 9 2 . 1 68 . 1 . 2 09 ea— » T ] hection has limited or no connectivity
Subnet Mask: 255.255.255.0 (&) Use the following DNS server addresses:
FPreferred DMS server
Altemate DNS server:
Default Gateway: 192.168.1.1

To change the network settings on your computer you may need addition information so please refer to
the computer manual.
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SDS 8020/8040 Data Logger

Menu List

The menu list shows the available pages displayed six at a time. To access the list, press the Esc key.
Depending upon where you are starting from, it may require pressing this button more than once. The
up () and down (W) arrows are used to scroll through the selections, which are repeated below. To go
to a specific page, either type in the page number and press Enter, or use the arrow keys to highlight
the selection and press Enter.

Operator Level — No Pass Code Reguired

1.

2.

10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

Overview Display

Display Input Settings

. Display Input Settings
. Display Input Offsets
. Display Logged Data

. Help

. Select Input Channels
. Modify Input Settings

. Modify Input Offsets

Select Survey Template
Battery Status
About/Sign-On

Revision Display

Set Display Values
Language/Lengua

Quick Chart

Overview Display Selected
Quick Chart Setup

Modify Survey Information

Supervisor Level — Level 1 Pass Code Required
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20. Set the Date and Time
21. Port Setup

22. Input Calibration

23. Cold Junction Trim

24. System Setup

Configuration Level — Level 2 Pass Code Required

25. Set Pass Codes
26. Set IP Address

Menu Pages 27, 28 and 29 are reserved for future use and do not exist at this time. To minimize the
possibility of unintended modifications to the instrument, certain menu pages will require the entry of a
pass code to access them. Pages 1 through 18 are Operator level screens that do not require any
security codes. Pages 20 through 24 are Supervisor screens requiring a Level 1 pass code (default = 1).
Pages 25 and 26 are Configuration screens requiring a Level 2 pass code (default = 2). At the bottom of
the menu screen is a status bar, which tells the current date and time. The status bar also displays the
internal temperature (IT) of the instrument. This internal temperature should never exceed 50.

Note About Menu Numbers

Each menu screen has a unique number that is displayed in the upper left-hand corner of the screen.
This number is shown for reference. If you know the menu number of the screen that you would like to
go to, the screen number can be typed and the enter key pushed to access that particular screen directly
from the Main Menu list or the Overview Display screen.
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Date and Time Quick Reference Chart

Month Code Day Code Hour Code Hour Code
January 1 Sunday 0 12 am 0 12pm 12
February 2 Monday 1 1 1 1 13
March 3 Tuesday 2 2 2 2 14
April 4 Wednesday 3 3 3 3 15
May 5 Thursday 4 4 4 4 16
June 6 Friday 5 5 5 5 17
July 7 Saturday 6 6 6 6 18
August 8 7 7 7 19
September 9 8 8 8 20
October 10 9 9 9 21
November 11 10 10 10 22
December 12 11 11 11 23
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Keypad Assignments

All of the functions of the SDS Data Logger are controlled from the keypad. The functions of each button

are as follows:

0 — 9 are used to enter numeric data that
can vary with each page

"." Is used to enter a decimal point where
necessary for data entry

Enter is used when entering numeric data
from the keypad or initiating automatic
functions

A and ¥ are used to navigate through the
menu options or scroll through data on a
specific page

ESC is the escape key. This clears any
entered text, and if continuously pressed,
toggles between the main page and the
menu list

()

ENTER

o Hh | W

2

ESC.

o | 00 N

1

The circular arrow key, 1¥, is used to scroll through data on various pages and to change the sign, +/-,

of values on some pages
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1. Overview Display
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The Overview Display shows the current readings of the five thermocouples on all four or eight boards,
depending on the number of channels. Pressing the circular arrow key will display the Quick Chart screen
(menu option 16). Pressing the up or down arrow keys will display the Modlify Input Offsets screen
(menu option 9). Pressing any of the number keys (1-9) will display the corresponding menu option.

2. Display Survey Information

Ee?aulf =
S51 - =coll
Batch 3
Agtiocn G stor. 1 sLart )t
surued TemPerature SetpPpoint:
To edit surwved values Press
Started =t:
StorFrred t.t

Enter?

Temil Mame H=+=zult
Combtand Hame 51
Furnace II Batch 32

Malke Mod=1 Milliam=
Furhnace T4 Eatch Gas Draw

HE=Feb=-Z885 Mon B2:44:13AHM

The Display Survey Information shows the survey information on the top half of the screen. Included is
the Template name, Company name, Furnace ID, Action (start or stop the survey), Survey Temperature
Setpoint, A field to edit the survey values, The Date/Time the survey was started and the Date/Time the
survey was stopped. Pressing the up or down arrow keys will scroll through the Action, Setpoint and Edit
survey fields. Pressing Enter on the line “To edit survey values Press ‘Enter” will display the Modify
Survey Information screen (menu option 19), which allows the user to modify some of the information
used in the survey. Currently, the only information that can be modified are the Setpoint, TC units, and
TC spool correction.

To start the survey, highlight the Action field, enter a 1 and then press Enter. Once a survey has been
started, “Testing” will appear in the highlighted area and the start Date/Time will be filled in the “Started
at” field.
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To stop a survey, highlight the Action field, enter a 0 and then press Enter. Once the survey has
finished, “Finished” will appear in the highlighted area and the stop Date/Time will be filled in the
“Stopped at” field.

To change the Setpoint, highlight the Setpoint field, enter in the new Setpoint and press Enter. Pressing
the circular arrow key while the setpoint field is highlighted will change the sign of the value entered.

The bottom half of the screen contains the full template data displayed five lines at a time: Template
Name, Company Name, Furnace ID, Furnace Make/Model, Furnace Type, Furnace Use, Furnace
Dimensions, Temperature Range, Date, Setpoint, Number of TCs, TC Type, TC Spool SN, TC Cal, TC Cal
Date, TC Spool Correction, SDS Calibrated By, SDS Cal Date, Duration, Operator, Interval, Specification,
TC Units, Simulated Load, Tolerance, Next Survey, Cont MFG, Cont Model, Cycle Time, Dead Band,
Output Limit, Prop Band, Rate, Reset, TC Gauge, and Notes. Pressing the circular arrow key will scroll
down through the template data, one line at a time. When the end of the template is reached, the scroll
will start over at the beginning of the template.

3. Display Input Settings
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The Display Input Settings shows the input settings for all five thermocouples on all four/eight boards.
Pressing any of the number keys (1-9) will display the corresponding menu option. Pressing the down
arrow key will display the Modify Input Settings screen (menu option 8).

Super Systems Inc. Page 18 SDS Data Logger Manual #4565 Rev D



4. Display Input Offsets

5

DISFLAY IMNFUT OFFSETS

I
1]

II
8]

Il
a
k2
ka

n
=
= E S

0 =JT A2
n
&

il lalld) |
n
&

0 o S
cn
&=

0 S
n
&=

S S ENE S

D=fault

The Display Input Offsets screen displays the offsets for all five thermocouples on all four /eight boards,
depending on the SDS type. Pressing the down arrow key will display the Modlify Input Offsets screen
(menu option 9). Pressing any of the number keys (1-9) will display the corresponding menu option.

5. Display Logged Data

b DISPLAY LOgGED DATH
Year ZEAE
Motk Fehl
Tad (=

Hioor- 2HM
To disrlad Pre== 7 EHTHSEEESETS-N

Default
He—Feb—2885 Mon B2:44: 15AHM

The Display Logged Data shows the logged data from a specific date, with the default setting being the
current hour of the current date. Pressing the down arrow key will allow the user to change the Year,
Month, Day, and Hour. To change the Year, highlight the area and enter any four-digit year between
1980 and 2179. To change the Month, enter a number corresponding to the appropriate month —i.e. 1
for January, 12 for December. To change the Day, enter a number between 1 and 31. To change the
Hour, enter a number between 0 and 23 corresponding to the appropriate hour —i.e. 0 for 12am and 23
for 11pm. Hours are based on the 24-hour clock. For a detailed reference for all of the codes, see the
Date and Time Quick Reference Chart section (Page 19). Pressing Enter on the line that says "To
Display Press ‘Enter’ here” will display the logged data.
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The first screen will display the first five inputs and the first ten minutes of data. Pressing the circular
arrow button will allow the user to scroll through the inputs, five inputs at a time. Pressing the down
arrow button will show the next ten minutes of logged data. Pressing the up arrow will show the
previous ten minutes of logged data. Pressing the ESC key will display the Disp/ay Logged Data Screen.

6. Help

The Help page can be used as a reference to briefly describe the functions of the various buttons on the
keypad. This manual is a better resource, however if it is not available this screen will be able to offer
information that will help in navigating through the screens on the SDS. To scroll through the screen
pages, press the down arrow key to scroll down and the up arrow key to scroll up.

7. Select Input Channels
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The Select Input Channels page allows the user to manually turn a thermocouple input “on” (“Yes") or
“off” ("No”). The thermocouples are displayed from one to twenty / forty. Use the up or down arrow
keys to select a specific thermocouple. Enter a 1 and then press Enter to turn the thermocouple on, or
enter a 0 and press Enter to turn the thermocouple off. Pressing Enter without entering a 1 or a 0 will
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turn a thermocouple off as well. Pressing the circular arrow key will display the Overview Display
Selected screen (menu option 17). Pressing the ESC key will also display the Overview Display Selected

screen.

8. Modify Input Settings

1s 17 1= 192
Z2.080 1,280 1edmr SEMW

Select inkPwnt. 1 Lo 482
Ent.er code for rands
To ==t ALL: enter code

IN=fault
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T
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Mon B2:244: 15AM

The Modify Input Settings allows the user to select a channel (input) and manually set the range/type, or
set the range/type for all of the channels. To select a channel, highlight the area and then enter a
number from 1 to 40 corresponding to the specific channel. Pressing the circular arrow key will scroll
through the input channels. To set the code for the range of one specific channel, scroll down to the
“Enter code for range” line and enter one of the codes from the list at the top of the screen. To enter a
code for all of the channels, scroll down to the “To set ALL, enter code here” line and enter the

appropriate code. The codes for the range are:

Num-Code Num-Code Num-Code Num-Code Num-Code Num-Code
0-B 3-1] 6 — NNM 9-T 18 —160mv 21 —20mv
1-C 4-K 7-R 16 — 2.56v 19 — 80mv 22 — 4-20ma
2-E 5-N 8-S 17 - 1.28v 20 — 40mv

Pressing the up or down arrow keys will scroll up or down through the three input fields: “Select input (1
to 40)” line, “Enter code for range” line, and “To set ALL, enter code here” line.

Super Systems Inc.
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9. Modify Input Offsets

o MODIFY IMNPUT QFFSETS

¥} ked o toddle =idn C+-—2 of wuglue.
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The Modify Input Offsets screen allows the user to modify the offsets of each channel, or to clear all of
the offsets. To select a channel, highlight the “Select Input” line and enter a number between 1 and 40.
To enter the offset value, highlight the “Enter offset value” line and enter a number between —1000 and
1000. The user can toggle the sign (+/-) of the number being entered by pressing the circular arrow
button. To clear out all of the offsets, highlight the “Enter 1 here to clear all offsets” line and enter a 1.

10. Select Survey Template

IR=H SELECT SURUVEY TEMFPLATE
Eritrd 1 of <l

Temelata?

TemElatel

Temelatad
T=fault

The Select Survey Template screen allows the user to manually select a template to run a survey from.
The SDS is capable of saving thirty-two templates per template file. Each template will be listed by
template name. To create a template, go to the Template Manager screen section, Manage Survey
Templates, using the SDS software and follow the procedures. To select a template, use the up or down

arrow keys to highlight the template’s name and press Enter. The Display Survey Information screen
will be displayed (menu option 2).
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11. Battery Status

11°¢= EATTERY STHTUS
Eatterd Llaltade = 15.8%
Eattery Condition = Charding
nCZ SurrErly = 14.8%
Internal SuPrld = 14.&=
DN=fault
HEe—Feb—-2085 Mon B23:442 15AHM

This page displays information about the instrument’s power supply.

Battery Voltage: This displays the DC voltage from the battery. It will read higher when the instrument is
plugged in, so a true measurement should be taken when it is not connected to AC power.

Battery Condition: This will display the battery status as Very Low, Low, or OK depending on the battery
voltage. When the instrument is plugged in, this will display Charging.

DC Supply: This will display the amount of power that is being generated by the internal power supply.
This will display 0 when the instrument is not plugged in.

Internal Supply: this will display the amount of voltage that the instrument is seeing. This is the greater
of the battery voltage and the DC supply.

If the instrument has been left unattended in the ON position, the battery may be completely dead. It
may be possible to recharge the battery, but it will take a few days to accomplish this. Leave the
instrument plugged in and periodically check the battery voltage to see if it is increasing. If it is increasing
the battery is taking a charge. Remember: it could take three to four days if the battery is completely
dead.

The instrument should not be plugged in after every use. The battery will last longer if it is discharged
for four — five hours before it is charged If the battery gets low, a warning message will appear on the
screen, followed by an estimate of the amount of time until it runs out of power. The operator will
always have at least an hour of run time after the message is displayed. When it is plugged in to
recharge, the instrument can still be used. The instrument will recharge and operate at the same time.
The battery has approximately twelve hours of battery life when fully charged.
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12. About/Sign-On
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The above screen is the sign-on screen that shows the SSi logo, address, and phone. This page will also
display the instrument model and serial number, the date of the last factory calibration, and the number
of hours and minutes the instrument has been in use since the last factory calibration. Pressing the down
arrow key will display the Revision Display screen (menu option 13).

13. Revision Display

13 FEUISION DISPLAY
Main Froces=sor 1.643
Sub Frocessor 1 1.&1
Sub FProcessaor 2 1.H61
Sub FProcessor 3 1.61
Sub Frocessor 4 1.681

Iefault
Ae—Feb—Z288S Mo 93244 15AM

This screen displays the firmware revision levels for the instrument. Although the user cannot modify this
information, it may be helpful to report when contacting Super Systems for support. The “Main
Processor” value is the main firmware revision number for the SDS data logger.
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14. Set Display Values

14 SET DISPLAY UHLUES
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TNl=fault
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This screen is used to adjust the display values. The backlight brightness and contrast are factory set to
40% and 50%, respectively, which is appropriate for most viewing conditions. Pressing the circular
arrow key will return these values to their default settings. The values for brightness and contrast can
range from 0 (dark) to 100 (bright). The backlight ON time is a power-saving feature that extends battery
life. The backlight ON feature will turn the backlight off if no buttons are pressed within a pre-
determined number of minutes. When the backlight goes off but the datalogger is not turned off, the
instrument is still functioning. The backlight can be restored by pressing any key. To disable this
function and keep the backlight always on, enter 0 and press Enter.

15. Language/Lengua

15= LAMGUAGE - ERMGLIA
Endlish
Endlish
Temlatez
He—-Feb-2085 Mon 83:44:15AM

This screen allows the user to select a language to be used on the instrument. The SDS Data Logger
arrives with the necessary languages already downloaded. The selected language will always be listed

above the selections. To select a language, press the up or down arrow keys to highlight the desired
language and then press Enter.
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16. Quick Chart
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This screen displays a trend chart for one active thermocouple over a period of ninety minutes. The
information on the right displays the active thermocouple number (TC), the temperature of that
thermocouple, the Setpoint (SP), the maximum value (Max) and the minimum value (Min). The
information on the left of the screen displays the full-scale value and the middle value as reference
points. Pressing the up or down arrow keys will display the Quick Chart Setup screen (menu option 18).
Pressing the circular arrow key will display the Overview Display Selected screen (menu option 17).

17. Overview Display Selected

17:= OUERUIEL DISFLRY SELECTED
Hotive ualues

)

E 12 1= 1=

E 121= 121s 1=21= 121= 1=1=

E 2315 2315 =315
Iefaunlt

He—Feb—-Z00% Mon B52442 13HM

This screen displays the active thermocouples on the instrument. Pressing the up or down arrow keys
will display the Select Input Channels screen (menu option 7). Pressing any of the number keys (1-9)
will display the corresponding menu item. Pressing the circular arrow key will cycle through the Survey
Deviation Alarm Log menu item (menu option 32) and the Overview Display screen (menu option 1). The
Deviation Alarm Log menu item will show all deviation alarms that were logged.
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18. Quick Chart Setup

1< T CE CHAET SETLIFE

Surwved setrPoint

TC it to chart
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Chart zero scale (5]
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This screen displays the setup information for the Quick Chart. Valid values for the setup information
are:

Survey Setpoint: 0 through 9999
TC input to chart: 1 through 40
Chart full scale: 0 through 9999
Chart zero scale: 0 through 9999
Reset min/max 1 = yes: Oorl

To change a value, highlight the desired value to change, enter in the new value and then press Enter.
Pressing the circular arrow key or the ESC key will display the Quick Chart screen (menu option 16).

19. Modify Survey Information

19: MODIFY SURVEY INFOEMATICON
SetrFroint FEIE_
TC Unit=s
TC Skraol Car -2
N=fault +
AS5—Feb—-2885 Mon B3:44: 15AM

This screen allows the user to modify some of the information used in the survey. Currently, only the
Setpoint, Temperature type (Fahrenheit or Celsius), and the TC Spool correction factor can be modified.
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To change any of these values, use the up or down arrow keys to highlight the field that is to be
changed, enter the new value, and press Enter. Valid values are:

Setpoint: -400 through 4000
TC Units: 0 for Fahrenheit and 1 for Celsius
TC Spool Correction: -100 through 100

For the Setpoint and the Spool Correction, the user can change the sign of the value by pressing the
circular arrow key. Pressing ESC will display the Display Survey Information screen (menu option 2).

20. Set the Date and Time

ZHs SET THE DATE AMD TIME

1. “ear %

Za MMornth =

- a'd =)
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= Houpr 1FM

- Minotes 54
Seconds =3
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Settind seconds =sets the clock.

Default

This screen displays the date and time information for the instrument’s internal clock and calendar. Press
the up or down arrows to navigate to the part of the Date/Time that is going to be updated. Once the
desired part is highlighted, enter the new number and press Enter. Months are numbers 1 (January)
through 12 (December). Days are numbers 0 (Sunday) through 6 (Saturday). Hours are based on the
24-hour clock with numbers 0 (12 am) through 23 (11 pm). No changes will take place until the seconds

have been entered. For a detailed reference for all of the codes, see the Date and Time Quick Reference
Chart.
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21. Port Setup
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This screen displays the parameters used for the communications ports. The factory default settings
should not need to be changed by the operator. To change the values that are not “"Modbus fixed”, press
the circular arrow key to cycle through the available values. Pressing Enter will set the value as the
lowest value.

22. Input Calibration

== IMEIIT CHLIEREATION

EBoard rnamber o cal ©1 tao 82 IIIE!EII
Cal ImnrFuot 1 C1 = Yes. B = Mo
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=1 IrnFuot 4 21 = Yes. B = Mol YE=
Cal Inkut 5 C1 = Yes. @8 = Hobl “ES
Fress Enter for calibration mods Feadu

z9.99 TZa.99 I9.99 Za..a99 IZ9.99
Nefault

This screen displays information to setup the calibration of the inputs. Calibration can be performed 1
channel at a time or from 1 — 5 inputs per board. The user can select board one through eight. The user
can also individually select each input (one through five) to calibrate, where 1 = yes (calibrate) and 0 =
no (do not calibrate). To continue the calibration setup, scroll down to the “Press Enter for calibration
mode” line and press Enter. This will display the setup for the calibration mode.
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The top of the screen displays the codes for the ranges. The codes are:
0-20MV 1-40MV 2-80MV 3-160MV 4—-1.28V 5-2.56V

Below is a listing of the suggested ranges for the various TC types.

TC Type mV Range Chart
TC Type Range in mV
B 20
C 40
E 80
J 80
K 80
N 80
NNM 80
R 40
S 20
T 20

To select a board to calibrate, highlight the first line (*"Board number to cal (1 to 8)"), enter the desired
board number that will be calibrated, then press Enter. The next line is the TCs (CH = Channels) to
calibrate. If there is a Y next to the TC, then it will be calibrated. If there is an N, then the TC will not
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be calibrated. To select the TCs to calibrate, enter a number between 0 and 31. To determine the
number, follow these steps:

TC1 has a “value” of 1, TC2 has a “value” of 2, TC3 has a “value” of 4, TC4 has a “value” of 8, and TC5
has a “value” of 16.

A TC that is on has a value of 1. A TC that is off has a value of 0.
Multiply the TC's value by its “value” and add all 5 TC values up.

For example, we wish to calibrate TC1, TC4, and TC5. TC1=1(1*1), TC2=0(0*2), TC3=0(0 *
4), TC4 = 8 (1 *8),and TC5 = 16 (1 * 16). The number to enter would be 1 + 0 + 0 + 8 + 16 = 25.
The line will now look like this: CH’s to cal 1Y 2N 3N 4Y 5Y.

To select the range to calibrate, select one of the codes above (0 through 5) and press Enter. The mV
ranges displayed above are ideal because they cover the mV range for the selected thermocouple type.

On the next line, enter a 0 for ZERO or a 1 for SPAN. Enter the target value (in MV) as a value ranging
from 0 to 320. The SPAN value should be 90% of full scale. That means for 80mV, the span value
should be 72mV. Scroll down to the next line and enter 1 to start the calibration. DO NOT START THE
CALIBRATION until you have entered the proper value in the calibration device. Also be sure that the
polarity of the wires is hooked up properly.

When the calibration is finished, the “Enter 1 here to start” line will read “Ready 0”. Pressing ESC will
display the Input Calibration first screen (menu option 22).

The calibration process can be run multiple times and if initial calibration is off significantly, running
multiple times is recommended.

23. Cold Junction Trim

The instructions for performing the Cold Junction Trim on the inputs will depend on the firmware level of
the instrument that you have. You can determine the firmware version be checking menu option 13
Revision Display. The number to the right of the first line, “Main Processor”, will be the firmware level.
Please select the instructions below based on the firmware level of the instrument.
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Firmware revision 1.09 or below

R coLD JUNCTION TEIM
Selact board number 1
Clear trims: 1 = Yes MO
Modify brd CJ bY C+r=2 H . 5
InFot 5 trim walue A, B8 Zall.9
InFut 4 trim walue % d. 6
InFut 3 Ltrim walue . H.D
InkFot 2 trim walue M. BH H. &
Inkwt 1 trim walue . FIE A. T

Husr-gda: 1 1 B
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This screen displays the setup information to trim the cold junction value of each board. Highlight the
first line (“Select board number”), enter the desired board number to trim, then press the Enter key. The
acceptable values for the board number are: 1 — 8. Any number entered over 8 will default to 8 and any
number entered less than 1 will default to 1. Press the down arrow key to highlight the next line (“Clear
trims, 1 = yes”). This line will allow an operator to clear out the previous cold junction trims for each
input. Enter a 1 for “yes” (clear input trims) or a 0 for “"no” (do not clear input trims), and press the
Enter key. Note — Clearing the trims will only clear out the cold junction trims for the selected board. If
the operator selected 1 (“yes”), the trims will be cleared once the Enter key has been pressed. Press the
down arrow key to highlight the “"Modify brd CJ by (+/-)" line. This will allow an operator to modify a
board’s overall cold junction value. See the section 7o Perform a Cold Junction Calibration below for
details on performing the cold junction calibration. Enter the desired cold junction trim value, and, if
necessary, press the circular arrow key to toggle the sign of the cold junction value. MNote — Pressing the
circular arrow key will also toggle the "Clear trims” value between "yes” and "no”. Press the Enter key
to begin the cold junction trim. When the trim has finished, the line will display 0.0, instead of the value
that was entered. This is because the offset is actually a recalibration of the board and after the
calibration process there will be no offset. If there are any trim values for the inputs, they must be
cleared before modifying the cold junction value for the board. If an operator attempts to change the
cold junction value without clearing the trim values, the “*Modify brd CJ by (+/-)" line will display “Clr
Trims”. To set each individual input’s trim value, press the down arrow key to highlight the specific input.
The inputs are listed from top to bottom starting with input five and ending with input one. Enter the
desired trim value, and, if necessary, press the circular arrow key to toggle the sign of the trim value.
Press the Enter key to set the new trim value. The input trim values range from —18.00 to 18.00. Note —
The overall Cold Junction value is modified by adding or subtracting a value to the current value. The
individual input trim values are set to the entered value.
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Firmware Revision 1.10 and above

Depending on the revision level of the internal input board, the screen will resemble one of
the two following screens. One version uses one Cold Junction Trim value that is applied to
the entire board. The other version uses a unique Cold Junction Trim value for each of the
five inputs on that board. The instrument will automatically determine which screen should
be displayed based on the internal boards that are installed inside it.

Input Board Version 1.07 and below
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This screen displays the setup information to trim the cold junction value of each board. Note — Since
the Cold Junction screen’s functionality changes slightly based upon the input boards’ version, it is
important to know which version of boards is in the SDS Data Logger. The input board version nhumber
will be displayed in the top right corner. Highlight the first line (“Select board number”), enter the
desired board number to trim, then press the Enter key. The acceptable values for the board number
are: 1 — 8. Any number entered over 8 will default to 8 and any number entered less than 1 will default
to 1. The next section of the menu screen will look like the following:

Input 5 trim value
Input 4 trim value
Cold Junction Trim
Input 2 trim value
Input 1 trim value

The line for “Input 3 trim value” is shown as “Cold Junction Trim” because this line controls the actual
cold junction trim. Input boards with version 1.07 and below only contain one thermister per board; so
only one cold junction trim will be needed.

See the section 7o Perform a Cold Junction Calibration below for details on performing the cold junction
calibration. The “Cold Junction Trim” will adjust all of the inputs simultaneously. Any trim value entered
for inputs 5, 4, 2, or 1 will not be reset during the cold junction trim; therefore, those inputs would be
even more offset after the cold junction trim. For best results, perform the cold junction trim first, then
perform any necessary input trims. Press the down arrow key to highlight the “Cold Junction Trim” line.
This will allow an operator to modify a board’s overall cold junction value. Enter the desired cold junction
trim value, and, if necessary, press the circular arrow key to toggle the sign of the cold junction value.
Press the Enter key to begin the cold junction trim. While the system is working, the word “Busy” will
appear below the “Input 1 trim value” line. When the trim has finished, “Busy” will disappear. To set
each individual input’s trim value, press the down arrow key to highlight the specific input. The inputs
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are listed from top to bottom starting with input five and ending with input one (except for input three).
Enter the desired trim value, and, if necessary, press the circular arrow key to toggle the sign of the trim
value. Press the Enter key to set the new trim value. Note — The overall Cold Junction value, as well as
any trim value, is modified by adding or subtracting a value to the current value.

Input Board Version 1.08 and higher
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The functionality of the Cold Junction Trim menu screen is similar to the Cold Junction trim for the input
board versions 1.07 and below. The difference is that the new boards have five thermisters, instead of
only one, so each board must have five cold junction trims performed. The middle of the screen will look
like the following:

Input 5 trim value
Input 4 trim value
Input 3 trim value
Input 2 trim value
Input 1 trim value

See the section 7o Perform a Cold Junction Calibration below for details on performing the cold junction
calibration. Press the down arrow to highlight the input to be trimmed. Enter the desired cold junction
trim value, and, if necessary, press the circular arrow key to toggle the sign of the cold junction value.
Press the Enter key to begin the cold junction trim. While the system is working, the word “Busy” will
appear below the “Input 1 trim value” line. When the trim has finished, “Busy” will disappear.

Firmware Revision 1.11 and above

With Firmware revision 1.11, the title of the menu option 23 has become “CJ Calibration” instead of “Cold
Junction Trim”.

To Perform a Cold Junction Calibration

The user will need a thermocouple calibrator capable of outputting a thermocouple signal to calibrate the
cold junction value of the data logger. The user will need to connect the calibrator to one of the inputs

on the data logger for the channel that will be calibrated. It is recommended to let everything (calibrator
and datalogger) sit for approximately thirty minutes to allow the temperature to achieve equilibrium. Set
up the calibrator for the specific thermocouple type of the thermocouples in the datalogger, i.e. type K,

type J, etc. Then, source a specific temperature, like 1000 °F to the connected input. It is recommended
that the actual temperature used be similar to an appropriate process temperature. For example, if your
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equipment normally operates at 1700 °F, then perform the cold junction calibration using a 1700 °F
signal.

Firmware Version 1.09 and below

The user can source temperature to any one of the inputs, since the cold junction value is separate from
the input trim values, even though there is only one thermister per board. If the temperature being
sourced does not match the temperature displayed on the screen, the user will need to adjust the cold
junction value (“*Modify brd CJ by (+/-) line) to match. After the cold junction value has been modified,
the user will be able to modify any of the input trims, if necessary.

Firmware Version 1.10 and above
Input Board Version 1.07 and below

The user will want to source the temperature to input three, since input boards with a version of 1.07 or
earlier only have one thermister, so the cold junction calibration will apply to the whole board. If the
temperature being sourced does not match the temperature displayed on the screen, then the user will
need to adjust the cold junction trim value to match. After the cold junction value has been modified,
the user will be able to adjust the trim values for inputs one, two, four, and five, if necessary.

Input Board Version 1.08 and above
The user will have to source the temperature to all five inputs, since input boards with a version of 1.08
or later have five thermisters per board, one for each input, so the cold junction calibration will have to

be made to each input separately. If the temperature being sourced does not match the temperature
displayed on the screen, then the user will need to adjust the input trim value to match.

24. System Setup
i H SYSTEM SETUFR

Surved deviastion Alarm Smart T X
Temrererature resolut.ion S wWWW.a

Tlefaunlt

This screen displays any system setup information. Currently, the only information available is the
Survey Deviation Alarm Smart and the Temperature Resolution. To turn the Survey deviation Alarm
Smart on, enter a 1 and press Enter. To turn the Survey Deviation Alarm Smart off, enter a 0 and press
Enter. The Temperature resolution field accepts a 0, 1, or 2 as a value. The temperature resolution
affects the resolution of the temperatures displayed on the data logger.
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25. Set Pass Codes

_t

SET FRSS CODES

Orerator Pass Cods
Lewus]l 1
Lews=] =2
Lewusl 3

I=fault

SukFervisor FPass Code
Confidur-ation Fas=s Cod
Skecial Pass Code {Cnﬂtact S=Ia

Ll P ST

This screen allows the user to set the pass codes to access the higher-level functions on the SDS. Menu
options 20 through 24 are considered Supervisor Level and they require a Level 1 pass code. Menu
options 25 and 26 are considered Configuration Level and they require a Level 2 pass code. The default
pass code for Level 1 is 1 and the default pass code for Level 2 is 2. There are 3 pass codes currently on
the SDS (there is no pass code for operator-level functions). To change the Level 1 Supervisor Pass
Code, use the up or down arrow keys to scroll to this line, enter the new pass code and press Enter.

The same is true to change the Level 2 Configuration Pass Code. Either of these pass codes may be
changed to a number between 0 and 512. Note: The Level 2 pass code will also work on all Level 1
menu options. The Level 3 menus are not visible, and Super Systems uses them when the instrument is

being set up prior to shipment.

26. Set IP Address

o SET IF HIDEESES
IF Addires=
192 1&2 =51 531
Met. Mask
235 235 255 HEAEA
IF Gatewad
192 162 HiE1 HiEA]
DNefault

This screen displays the Ethernet communications address information. To change the IP Address, Net
Mask, or IP Gateway, use the up or down arrow keys to scroll to the appropriate section, enter the new

number and press Enter. To set the changes, scroll down to Set and press Enter.

Note — if the

changes are not set, then no changes will be saved.

Super Systems Inc.
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32. Survey Deviation Alarm Log

s SURUEY DEVIATION ALARM LOG
Surwved Jewviation Hlarms
AL 1 Start at 1522 End at 15: 36

Ll Lk Ll Ll Ll

=0 = A D

0oL HL 2 Hidh 2 Low!

The survey deviation alarm log will log all instances where the temperature of one of the survey channels
goes above or below the deviation band. The alarm log is on a one-minute update, so any alarm would
have to be present for more than a minute to be logged. The start and stop time of the alarm is listed at
the top of the screen on the line “"AL 1 Start at”. The screen will display the each channel and which
channel was high or low. This log will be cleared out when the next survey is run.

34. Clear Logged Data
T H CLEARF DHTALOG TIHTH

tion will =rase

Th H=
1 gatalnﬁ dats!!
=

a
Fre=s=
Lo

is
*17¥ fhen_ "EHTER? kew
bedipn clearind. ]

SDESEEEHAN

This screen will allow the user to clear out the logged data. This menu option is only accessible with the
SSi Special pass code that can be obtained from Super Systems Inc support. To begin clearing out the
datalog data, enter a 1 and press Enter. The middle-left of the screen will display “*** Busy ***” while
the SDS instrument is clearing out the data. When the instrument is finished clearing out the datalog
data, the message will change to “Clearing complete.” If there was an error, the SDS instrument will
display “File error -13". For SDS firmware versions 1.09 or lower (SDS menu 13 — Revision Display), it
is suggested that the datalog files be periodically deleted from the SDS data logger. All survey data that
is captured on the data logger is transferred to the PC using the SDS Reporter software and can be
reviewed at any time from that PC. Any data logger that retains datalog files for more than one hundred
ten (110) days, or roughly three and a half (3 2) months, will begin to experience issues with the data
logger. Datalog files can also be deleted by using the SDS — Download Surveys and Data menu option
on the SDS Reporter software to bring up the survey download screen. From the Download screen, the
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Options — After Downloading — Delete datalog files from SDS menu option will delete the data log files
from the SDS after they have been downloaded to the local computer. Note: Once the datalog files have
been downloaded to the local computer, they will not be automatically deleted by the SDS Reporter
software. The only way to delete those datalog files will be to delete them manually. Note — With
firmware version 1.10, when the file space begins to get low, every screen will begin to flash the
message "Flash Card Space Low!” at the bottom of the screen. If the file space eventually does get filled
up without any data log files begin deleted, the SDS Data Logger will begin to delete the oldest files.
When this happens, every screen will begin to flash the message "File Deletion is occurring!”
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SDS Software

SDS Reporter

&3 Super Systems inc. SDS Reporter
Ele 5DS Options Help

NEE =R

SDSReparter - Aeady )
- W — i — i —_—

Figure 2.1 SDS Reporter initial screen

When the SDS Reporter software is started up, the user sees the above screen.(figure 2.1). The four
menu options to choose from are: File, SDS, Options and Help. There are four buttons to choose from:

New n , Open ' save = and Print &

File Menu Options

File > New / New Button -

The New option allows the user to create a new report that will include the report properties, the trend
chart, and the TC data (figure 2.2). Note: the selected tab will be in Red when it is active only for the
three main tabs — Report Properties, Chart, and Data.
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&3 Super Systems inc. SDS Reporker
Eile 3DS oOptions Help

HE =

Repart Properties I Chartl Data I

Report IFumace | Survey Box I Thermocouples I Survey Detalls | Survey Parameters I Controllsr I User Defined

—Data Sources

Data ‘ |_|
Report Template: [ |_|

—SDS Report
Report Heading [ Title ‘ |

Survey Results (PassfFail) | |

[ Mates

SDSRepoiter - Ready
= e —

Figure 2.2 Report Properties Tab

File > Open / Open Button'—~

The Open menu option will allow the user to choose an existing report from a common Windows Open
dialog box. The software will open the dialog box in the “SDSReports” folder (typically -
C:\SSi\SDS\SDSReports) for existing reports (.SDSReport) to open.

The Report Properties tab contains several tabs, which in turn contain the information that makes up the
report. The first tab is the Report tab (figure 2.3), which contains the data to use for the report, the
report template to use, the report heading or title, the survey results, and any notes about the report.
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~I Furnace I Survey Box I Thermocouples I Surveyw Details I Survey Parameters I Zonkroller I User Defined I

—Data Sources

Daka | | . I
Repork Template: | | e I

—SDS Repork
Reporkt Heading ' Tikle | |

Survey Results (PassFail) | |

— Moktes

Figure 2.3 Report Properties Report tab

Clicking on the open box, —| , hext to the "Data” field will display a screen from which the user can
select the interval time (ten seconds, twenty seconds, thirty seconds, one minute, two minutes, or five
minutes) and also the specific survey to use (figure 2.4). This screen will only display survey data that
has already been downloaded (SDS — Download Surveys and Data).

&> Load Survey Data = O] =|
Data Interval: I-I Minuite \;b
[Manual Entry] [SDSE0S000) 04/25,/2006 11:20 Ak - SO0 PM— -
[Marual Entre] [SDS505000] 04/24,/2006 10:45 PR - 3:30 A

[Farnual Entry] [SDS505000) 04/24,/2006 4:16 Phd - 4:20 Phd

[Farnual Entry] [SDS505000] 04242006 1246 P - 1:46 Pk

TemplateZ: [Super Systemns Inc - Batch 1] [SDS505000] 04072006 12:37 P - 12:42 P

SD5505000; [SDS505000] 040720068 1210 P - 12:27 PR

Template2: [Super Systems Inc - Batch 1] [SDS5050007 040720068 10:50 Ak - 10:53 Ak

Template2: [Super Systems lnc - Batch 1] [SDS505000] 040720068 10:27 Ak - 10:23 Ak

[Marual Extry] [SDS505000] 04,/04/2006 10:00 AR - 17:00 Ak ;I
Advanced: Manually Create Survey Hecord

Cancel I e I

A

Figure 2.4 Load Survey Data screen

The default interval is one minute. Select the survey to use and click on the “Use” button. Information
included with the data sources is: Template Name, [Company Name - Furnace Id], (Survey box Serial
number), and the date/time range of the survey data. Any manual entries will have [Manual Entry] at
the beginning. See the section Manually Creating a Survey Record for information on how to add a
survey record manually. Clicking on the open box next to the “"Report Template” field will open a dialog
box from which the user can select the specific report template to use for the report. The software will
open the dialog box in the "SDSReportTemplates” folder (typically C:\SSi\SDS\ReportTemplates) for
existing report templates to use. The “"Report Heading / Title” field is for the heading or title of the
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report and the “Survey Results (Pass/Fail)” field is for the results of the survey. The “Notes” field is for
any general notes for the report.

Manually Creating a Survey Record

Clicking on the “Advanced: Manually Create Survey Record” link from the Load Survey Data screen will
allow the user to create a survey record to use. Clicking on this link will display the “"Manually Create
Survey Record” form (figure 2.5). Five pieces of data are required to manually create a record: the SDS
model, serial number, the start time and date of the survey, the end time and date of the survey, and the
TC Spool Offset.

== anually Create Survey Record — =) =1

Llze thiz form o manuallp create a survey record. This may be us=eful in certain
zituations where survey data cannot be obtained from the listed survey records.

Sursew Box Madsl: |55 Model 5058020 O atalogger =1
Survey Box Serial Mumber: r|
Survey Start: I E0:21 Pr = || 04424508
Surwey End: I HE0:21 P > | D4424506
TC Spool Offset: ID

Cancel I Add Fecord I

Figure 2.5 Manually Create Survey Record form

The drop-down list next to “Survey Box Model” contains a list of the available models, the SDS8020 and
the SDS8040. Select they model type. Enter the SDS serial number on the next line, “Survey Box Serial
Number”. The SDS model and serial number can be found on the About / Sign-on menu, menu option 12
on the SDS instrument. The process for selecting the start date/time and the end date/time is the same.
To select a date, click on the down arrow next to the time listed. This will bring up a calendar from
which the user can select a new date (figure 2.6). Select the new date by clicking on it.

N =i

ally Create Survey Record — |I:I| X|

Uze thiz farm to manually create a zurvey record. Thiz may be uzeful in certain

-l
; gituations where survey data cannot be obtained from the listed sureey records. f

T f

$ Survew Box Model: [55) podel 5058020 D atalogger =1 :

T Survey Box Serial Mumber: I H

T

T Survey Stark: |11:30:DD ik vI 04/25/06 LI

Survey End: [l 4| April. 2006 =  Fiecord
TC Spoocl Offzet: Sun Mon Tue wed Thu Fri Sat y

L— 2B 27 28 29 30 ca | 1 &

Cancel | 2z = 4 5 B 7 &
a 10 11 1z 13 14 15

16 17 18 19 =20 21 22
23 ©Z4heE® 26 7 28 29
=m0 1 0z % 4 5 B

< > Today: 04/24/2006

Figure 2.6 Select new date

The date of the survey start /end is listed to the right of the drop-down list. To select a time, click on the
hours, minutes, seconds or "AM/PM”. The selected field will be highlighted. Each field can be changed
by using the up or down arrows on the keyboard. If the survey start date is later than the survey end
date, a message will be displayed to the user and the record will not be added (figure 2.7).
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)

x|

0 Error: Survey skart date is after survey end dake

Figure 2.7 Survey start/end date error message

Enter the TC spool offset and click on the “Add Record” button to add the record. Clicking on the
“Cancel” button will cancel the add process and bring the user back to the “Load Survey Data” dialog
box. If the add was successful, a message box will be displayed (figure 2.8).

SDSReporker =]

@ The record was added.

Figure 2.8 Record Add successful message

The added record will be displayed chronologically in the top of the list. Any record manually added will
begin with “[Manual Entry]” (figure 2.9). If the manually created survey is less than one second, it will
not be displayed in the list.

&3 Load Survey Data — 1ol =]
D ata Intersal: I-I hinuite ;I
[k arnual Entry] [SDS505000] 04,/25/2006 11:30 40 - 4:00 PR -
[k arnual Extry] [SDS505000] 04/24/2006 4:16 PR - 4:20 PR
[k arnual Entry] [SDS505000] 04/24/2006 12:46 Fh - 1:46 Pk
TemplateZ: [Super Systems lhc - Batch 1] [SDS505000] 040772006 12:37 P - 12:42 PR
SD55R05000; [SDS505000) 04072008 1210 P - 12:27 PR

Templatez: [Super Supztems lnc - Batch 1] [SDS505000] 044072006 10:50 Ak - 10:53 Ak
TemplateZ: [Super Systems Inc - Batch 1] [SDS505000]1 0407 /2006 10:21 Sk - 10:23 Ak

kM anual Entrp] [SDS505000] D404/ 2006 10:00 Ak - 17:00 Ak
TemplateZ: [Super Spztems lnc - Batch 1] [SDS505000] 03/27 /20068 17:04 Akd - 11:08 Ak ;I
Sdvanced: Manually Create Survey Becord

Cancel I Usze I

Figure 2.9 Manual entry on Load Survey Data form

Note — Most of the “"Report Properties” tabs (Report, Furnace, Survey Box) will need to be filled out
manually as well.

The next tab is the Thermocouples tab (figure 2.10). This tab contains the information about the
thermocouple settings and it also lists the active thermocouples. The information in the thermocouple
settings includes: the temperature type (F or C), the number of thermocouples, the number of TCs used
in the report, the thermocouple type, the thermocouple gauge, the thermocouple spool number, whom
the thermocouple was calibrated by, the date the thermocouple was calibrated, and the thermocouple
spool correction factor. Clicking on the “Change” button will allow the user to change the spool
correction (figure 2.11).
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‘I Surwew Details I Surwvew Parameters I Cantraller I Lser Defined I

Repork I Furnace I Surwvey Box ‘

— Thermocouple Settings=s

Temperakture Type (F ar C)

Mumber of Thermocouples # TZs Used in Repork

Thermocouple Sauge I:l

Thermocouple Spoal Mumber |2458

Thermocouple Calibrated by |

|
|
Calibration Dake | |
|

Thermocouple Spool Correckion Fackor  |-1 “hange

—ackive Thermocouples

1 e I+ 11 M 16 — z1 I za I =1 I s
~ =z = — 1z iz — z= | = — sz - =7
I = r s v 13 I 1is I == I zs I == I 3s
=+ I~ o — 14 I~ 19 I =4 I z9 I = . =92
s I~ 10 I+~ 15 I zo 25 I 3o 35 I 40
Crefine Control TC Wieww OFfsets used in Surve

Figure 2.10 Report Properties Thermocouples Tab

Mew Spool Correction Factor Dialog =|
Fleaze enter the new offset
Cancel I

Figure 2.11 Spool Correction screen

All values displayed to the users are corrected. That means if there is a defined offset for the TC
Spool and a channel offset, the user would be shown the net result of those offsets into the value

displayed.

There are checkboxes for a possible forty thermocouples, but only the active thermocouples will have
checks in the checkboxes. Clicking on the “Define Control TC” link will allow the user to select the TC or
TCs that will be the control TC(s) (figure 2.12). The operator can select any of the thermocouples to be
the control TC(s) and provide an optional description for that TC.
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Define Control Thermocouples =]

Cfrack off #1e frecmocouofes afycfT ae comfinod Fls Youw smap afso
AOLTIE 3 dEscnniiT for aaclt corninad T

D escription D escription

Wwo- o OEwn =

77T 1777 7777 717717
77T 1777 7777 717717
[71)

Accept Cancel

Figure 2.12 Define Control TC screen

Clicking on the Accept button will set the selected control TC(s). Once a control TC(s) has been selected,
the TC's number will be in Red on the “Active Thermocouples” section of the Thermocouples tab. 7Ae
thermocouple(s) that is identified as the control TC will not be used for the TC summary when identifying
hottest and coldest channels.

Clicking on the “View Offsets used in Survey” link will display a list of the offsets that were used on the
survey (figure 2.13). All values that are displayed to the users are corrected values. That means
the Offset defined for these TCs have already been incorporated into the value the operator would see.
IF there is a value for the TC Spool Correction Factor, that value will also be incorporated providing a
corrected view for the user.

TSI
TC I Offsek I
TCA u]

TCZ2 [u]
TC= [u]
TCS u]
TC10 u]
TC11 o
TC13 [u]
TC1S [u]
TC1E u]
TC139 u]

Close I

Figure 2.13 TCOffsets screen
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Note: Checking or unchecking TCs on the Thermocouples Tab will affect the TCs plotted on the Chart
Tab.

The next tab is the Furnace tab (figure 2.14a and 2.14b), which contains the furnace ID, the make and
model of the furnace, the furnace type, the furnace use, the furnace’s operating range, the furnace
dimensions, the furnace class (newer versions only), and an optional image of the furnace.

FReport  Furnace ]Sur'-.-'e',.-' Box ] Thermocouples ] Surwvey Details ] Surwvey Paramekters ] Conkroller ] User Defined ]

Furnace Details

Furnace I |Batch 3 |

Furnace Make [ Model |Furnace MFg|

Furance Twpe |Bal:ch Gas Draw

Furnace Operaking Range |—35EI—1EIDD

|
|
Furnace Use |Batch |
|
|

Furnace Dimensions |25x12x10

Load Map Image

Figure 2.14a Report Properties Furnace Tab (Version 1.101.0.76 & below)

Furnace Details

Furnace ID |# 103 |

Furnace Make | Maodel |I|:|sen 1842 |

Furnace Tvpe |'-.-'acuum - Zbar Quench |

Furnace Lse |Heat Treating |

Furnace Operating Range |IDDD-24DD |

Furnace Dimensions |6Ij" « 60" |

Furnace Class I:I

Load Map Image

]

Figure 2.14b Report Properties Furnace Tab (Version 1.101.0.80 & above)
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Clicking on the open box next the image frame will open a dialog box where the user can search for an

image of the furnace to use.

The next tab is the Survey Box tab, which contains information about the survey box itself, such as the
make and model, the serial number, whom the survey box was calibrated by, and the calibration date

(figure 2.15).

Fepork ] Furnace '

Surwveyw Box

Surwvey Box

Surwveyw Box Serial Mumber

Make/Model |

Survey Box Calibrated By |

Surwvey Box Calibration Dake |

Figure 2.15 Report Properties Survey Box Tab

The next tab is the Survey Details Tab (figure 2.16). The Survey Details tab contains the company name,
the survey start date, the survey duration, the actual duration of the survey, the survey specifcation(s),
whom the survey was performed by, whom the survey was approved by, the date range for the survey,

and the due date of the next survey.

Repork ] Furnace ] Survey Box ] Thermoc

Survey Dekails

Company MName
Survey Skark Dake
Surwey Durakion
Surwey Specifications
PerfFarmed By
approved By

Dakte Ranges For Surwesy

Mexkt Survey Dus

ouples ;-

,] Survey Paramekters ] Zontraller ] User Defined ]

|Super Swskems inc

|DEI:3EI:DEI

Ackual:

|.c-.M5 27F50-C

|Tirn Kell

Figure 2.16 Report Properties Survey Details Tab
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The next tab is the Survey Parameters Tab (figure 2.17). The Survey Parameters tab contains: the
survey tolerance, the survey setpoint, the overtemp setpoint, the simulated load in pounds, and the
microns.

Repork ] Furnace ] Survey Box ] Thermocouples ] Survey Details | Survey Parameters ] Contraoller ] User Defined ]

Survey Paramekers

Survewy Tolerance [+1-] |1D

Survey Sektpoink |—200

Simulakted Load ({Ibs) |SDD

|
|
Crverkemp Sekpoink | |
|
|

Microns |

Figure 2.17 Report Properties Survey Parameters Tab

The next tab is the Controller Tab (figure 2.18a and 2.18b). This tab contains the Controller
manufacturer, the controller model, and the instrument type (newer versions only) in the “Temperature
Controller Settings” area and this tab also contains the PID Settings: cycle time, dead band, output limit,
PB (Gain), rate, and reset.

Repork ] Furnace ] Survey Box ] Thermocouples ] Surwveyw Details ] Survey Parameters  Controller ]l_lser Defined ]

Temperature Conkroller Sektings

Zontroller FMFPg. | |

Conktroller Model || I

PID Sektings

Zwcle Time

Dead Band

PE {=ain)

Rate

I |
I |
Cakpak Limik | |
I |
I |
Resek | |

Figure 2.18a Report Properties Controller Tab (Version 1.101.0.76 & below)
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Repork ] Survey Parameters ] Survey Details ] Thermocouples ] Survey Box ] Furnace ’ User Defined ]

Temperature Controller Settings

Zontroller MFg. |H0neywe|l |

Controller Model |I_IDC 300 |

Instrument Type I:I

PID Settings

Cyele Time |2|:| |
Dead Band | |
Cukput Limit [too |
PE {(Gain) [z.7o |
Rate [z5 |

Reset |1 .25 |

Figure 2.18b Report Properties Controller Tab (Version 1.101.0.80 & above)

The last tab in the Report Properties tab is the User Defined Tab (figure 2.19a and 2.19b). This tab
contains ten (version 1.101.0.76 & below) or twenty (version 1.101.0.80 & above) fields that can be
defined by the user and included in the report.

Repork ] Furnace ] Survey Box ] Thermocouples ] Survey Details ] Survey Parameters ] Conktroller ‘

User Defined 1|

User Defined 2|

User Defined 3|

User Defined 4|

User Defined 5|

User Defined Eu|

User Defined ?|

User Defined EE|

User Defined 9|

User Defined 1EI|

Modify User Defined Fields

Figure 2.19a Report Properties User Defined Tab (Version 1.101.0.76 & below)
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Report ] Survey Parameters ] Survey Details 1 Thermocouples ] Surwey Box ] Furnace ] Caonkraller

Modify User Defined Fields

User Defined Tag 1 |

User Defined Tag 2 |

Lser Defined Tag 3 |

Lser Defined Tag 4 |

User Defined Tag S |

Uszer Defined Tag & |

LUzer Defined Tag 7 |

LUzer Defined Tag 2 |

User Defined Tag 2 |

User Defined Tag 10 |

Lser Defined 11|

Figure 2.19b Report Properties User Defined Tab (Version 1.101.0.80 & above)

To create a user defined field, click on the “"Modify User Defined Fields”. This will display a screen that
will allow the user to edit the fields (figure 2.20). The user can type in the name or description of the
field and click the “Save” button.

Edit User Defined Fields |

User Defined 1 : |HEZEEETN==N]

User Defined 2; |User Defined 2

User Defined 3: [User Defined 3

Uszer Defined 4: I'—'S‘Er Defined 4

User Defined 5; [User Defined 5

Uszer Defined &: I'—'S‘Er Defined &

User Defined 7: [Ussr Defined 7

User Defined &: [User Defined 2

User Defined 9; |User Defined 3

User Defined 10;: [User Defined 10

Cancel I Sawve I

Figure 2.20 Edit User Defined Fields screen
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The Chart Tab (figure 2.21) contains the charted information from the time specified on the survey. This
tab is similar in design and function to the Real-Time chart (figure 2.40). When the chart tab is active,
the chart toolbar buttons also appear and these buttons can be used to zoom in on a section of the chart,
pan the chart up, down, left or right, and refresh the chart back to its original values. The screen will
display 2 horizontal lines that represent the high and low temperature tolerance levels based on the
setpoint. This display will change based on the tolerance level and setpoint defined in the Report
Parameters. For more information about the function of this screen, see the section “"SDS > View
Real-time Data.”

< Super Systems inc. SDS Reporter =10 >
File sD= options  Help

= E SN N

Report Properties I Chartl Daka I

03/26/2006 12:09:13 AM
Plot [[watue = [ ==
TC1 361.7 3
3
TC3 362.9 =
TCa 352.6 E
TC S 352.4 700 =
TC & F6.5 El
TC7 | 25019 E
TCa 2501.9 500 3
TGS E
TC 10 500 =
OrTc11 3
Orc1z a00 E
[ R R E] E
OTcaa 3 T
O cas 300 =
Orew - \
] 200 =
| E
] 3
Orczo | = 100 = |~
o =
] P
Clice2s | =
] = 3
[ 100 =
| E
] 200 =
=] E
Clvc2s | = E
CITC 30 | === L R T
[ e =1 7:00 PM 715 PR
= Time
|Survey Start: 4:36:13 PM |Survey End: 7:44:13 M Duration: 2.15:08:00 g

Figure 2.21 Chart Tab

Note: checking or unchecking TCs on the Chart Tab will affect the Active TCs on the Report Properties —
Thermocouples tab.

The Data Tab (figure 2.23) contains the data from each thermocouple for the each interval selected from
the Load Survey Data screen (figure 2.4).

File SDS options  Help

MEREIE

Repart Propertios | chart | Data |

Tirne = = Tes = Tes Tee Ter Tes =) Teio
» 6:33:18 PM FTE 70.9 &9.9 71 FO.1 3.5 2501.9 2501.9 2501.9 Z2501.9
sizmizaFPM v 7o0.5 s5.5 Fo.e so.= a7 zso1.9 zs01.2 zs01.9 zs01.9
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Figure 2.23 Data Tab
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Clicking on the “Round this data off to the nearest degree” link will pop up a message box confirming the
action (figure 2.24). The rounding only affects imported data. The data in the logged files will still
contain data rounded to one decimal place. Clicking on the “Yes” button will round the data.

Round data to nearest degree? x|

Are vou sure wou wank ko round this data off to the nearest degree?

Mote: This will only modify the imported data, the logged data fFiles will skill contain daka to one decimal place.

me |

Figure 2.24 Round data confirmation

File > Save / File > Save As / Save Button =

This will save any changes made to a new or existing report. If an existing file was opened, then the
software will automatically save the file without prompting. If a new file was created, then the software
will display a common Windows Save dialog box that will allow the user to save the report to the
“SDSReports” folder. Once the report has been saved to the "SDSReports” folder, the software will
automatically save the file the next time the save command is chosen. Clicking the Save As menu option
will automatically bring up the Save dialog box.

File > Export

There are three sub-menu options available for the export function:

Export Report to Word
Export Report to RTF
Export Survey Data to CSV

The Export Report to Word menu option will export the report to a Word document format, which will
provide more detail than the standard .rtf file format, if that option is desired. When this menu option is
clicked, the software will automatically begin to export the report selected to a word document. Once the
report has been exported, the new document will be displayed. Note — no save dialog box will be
displayed to the user. Initially, the report is saved as “temp.doc” to the “C:\Temp"” directory. The user
can rename and save this report to any other desired location. Note — any time this menu option is used,
the resulting report will be saved as "temp.doc”, so any previous report that has not been re-saved will
be lost. The Export Report to RTF menu option will export the report to a rich-text format (RTF). When
this menu option is clicked, the software will display a Windows Save dialog box that will save the .rtf file
to the “"SDSReports” folder. The Export Survey Data to CSV menu option will export all of the survey
data (as seen on the Data tab) to a comma-separated value format file. When this menu option is
clicked, the software will display a Windows Save dialog box that will save the .csv file to the
“SDSReports” folder.

File = Print

This menu option is slightly different from the print button. There are four sub-menu options available:

Print Report

Print Survey TC Data
Print Approach TC Data
Print All
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The Print Report menu option will allow the user to print out a copy of the .SDSReport file. The user will
have to select the printer to print the report (figure 2.26).

Zlx|

— Printer
HMame: vrnLexmark Optra 5 2420 Froperties. .. I
Status: Feady
Type: Lexmark Optra 5 2420
wihere: LexmarkPS
Comment: ™ Print ta file
— Print range Copies
oAl MHumber of copies: |1 E:
i Pages  from: b
F | e
) Selectian 2 3
ok I Cancel I

Figure 2.26 Print prompt screen

The Print Survey TC Data menu option will print out a copy of the TC data (as seen on the Data tab). The
user will have the option to configure the page settings and select a printer to print to (figure 2.26a).

Page Setup El El

Orientation

= Portrait

T Landscape

Auto Select -
k argins [Inches]
L =Ft: 0.5 Bight: 0.5
Top: s Bottom: |05
Ok I Cancel | FErinter. .. |

Figure 2.26a Page Setup screen

The Print Approach TC Data menu option will allow the user to just print the approach data in a tabular
format. The Print A/l menu option will print all of the options — Report, Survey TC Data, Approach TC
Data — at once. The user will be able to select the printer (figure 2.26). All three options will be printed

as separate reports.
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Print Button &

When the user clicks on the Print button, the software will display the print preview screen, which is
similar in design and function to the print preview screen on the View Real-time chart (figure 2.41 or
figure 2.27 below).

File = Print Preview

The print preview screen is similar in design and function to the print preview screen on the View Real-
time chart (figure 2.41) and is displayed here (figure 2.27). See the section “Print Button” under the
SDS - View Real-time Data menu option for an explanation of the screen. There are three sub-menu
options available:

Print Preview Report
Print Preview Survey TC Data
Print Preview Approach TC Data

Each option will display a print preview of the desired report.

ﬂgPrint preview

& O -6 0 E 6 @[ cos- | :

Figure 2.27 Print Preview screen

File > Exit
This menu option will exit the application.

SDS Menu Options

SDS 2> Manage Survey Templates

The Manage Survey Templates menu option will display the SDS Template Manger screen, which will
allow a user to add new templates and modify existing templates. See the section SDS Template
Manager Screen for a more detailed description of the functions of this screen.
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SDS - Download Surveys and Data

The Download Surveys and Data menu option will allow the user to download surveys from a specific SDS
instrument. When the menu option is clicked, the SDS software will begin to search for any and all
dataloggers located on the network (figure 2.29).

2 SDSE0XX Data Downloader — 13l =]
File Options
SDs: |[192.188.1.21?]SSI tdodel SOS8020 Cratalogger SH SDS505000 vI

=

Searching for SDS. ..

Finizhed searching. Found 1 SD5.
=]

Crovenload I

A

Figure 2.29 SDS80XX Data log Extractor screen

Any datalogger found on the network will be added to the drop-down list at the top of the screen. If no
devices are found, a message box will pop up letting the user know that no devices were found on the
network (figure 2.30). Check the network connections to verify that any datalogger and computer is
properly connected to the network.

SDSReporter Xl

Mo SDS were Found. ..

Figure 2.30 No SDS devices found

Select the instrument from which to download the data files from the drop-down list box labeled “SDS:".
Note: Currently, the drop-down list will also populate with any Video Recorder data loggers as well. Use
caution when selecting the instrument to download data from, since downloading/deleting data from a
Video Recorder using the SDS Reporter software could cause undesirable consequences. Under the
Options menu, the Download menu option (figure 2.31) will allow the user to choose to download only
data that has been used in surveys, or all of the logged data. The SDS data logger will log data
continuously when it is on regardless if a survey is running or not. There will be a check mark next to
the menu option selected. The default menu option is Only data used in surveys.

2 SPSBOX X Data Downloader
File [Esl=ldfalgt]
Dovwnload. .. - Is: [192.162.1.211]1 55| Model SD52040 Datalogaer SH SODSTEEMCH
3

After Downloading. ..
Searc Dirive »
Finizhegsearcmig FOuAd 3 50rsT

Dovernload |

Figure 2.31 Download menu option
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The After Downloading option will allow the user to delete the data files from the SDS instrument, or
keep them on the instrument when the files have finished downloading. Choosing the After Downloading
— Keep datalog files on SDS menu option will keep the datalog files on the SDS data logger. Choosing
the After Downloading — Delete datalog files from SDS will delete the datalog files from the SDS data
logger. Note: Once the datalog files have been downloaded to the local computer, they will not be
automatically deleted by the SDS Reporter software. The only way to delete those datalog files will be to
delete them manually. For SDS firmware versions 1.09 or lower (SDS menu 13 — Revision Display), it is
suggested that the datalog files be periodically deleted from the SDS data logger. All survey data that is
captured on the data logger is transferred to the PC using the SDS Reporter software and can be
reviewed at any time from that PC. Any data logger that retains datalog files for more than one hundred
ten (110) days, or roughly three and a half (3 2) months, will begin to experience issues with the data
logger. Datalog files can also be deleted by using menu option 34 on the SDS data logger (Clear Logged
Data). Note — With firmware version 1.10, when the file space begins to get low, every screen will begin
to flash the message "Flash Card Space Low!” at the bottom of the screen. If the file space eventually
does get filled up without any data log files begin deleted, the SDS Data Logger will begin to delete the
oldest files. When this happens, every screen will begin to flash the message "File Deletion is occurring!”

The SDS software will begin to download the survey data once the user has clicked on the “Download”
button (figure 2.34). The button will read “Abort” while the data files are downloading. If a connection
to the SDS device cannot be established, the software will display a message box informing the user
(figure 2.32).

SDSReporkter XI

Cannok establish a conneckion. Be sure that no okher programs are FTPINg inka ik, IF the problermn conkinues, try restarting the
survey box,

Figure 2.32 Cannot establish a connection message box

If the user chose to only download data files used in surveys, and no data files are found, the software
will display an error message (figure 2.33).

MNO Surwveys |
@ Mo survey records wvwere Found.
= |
Figure 2.33

The files will be downloaded to: SDS\(SDS Model number)\log(year), i.e., SDS\SDS505000\log2006.
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&3 5DSB0XX Data Downloader =10 x|

el Epkions

SD5: I['I 92.168.1.217] 551 Model SDSE020 Datalogger SM 505505000

b L

Connection Successfull

Attempting bo navigate to 192.168.1.217/E/
Connecting ko 192.168.1.217...

Connection tnp #1

Atkernpting to Connect...

Connection Successfull

Atternpting bo navigate to 1921681 217 /E/
Searching for log folders.

Faund log falder: lag2005

Faund log falder: lag2008

Laoading datalog file list...

Changing directory ta AE Alog20054

Abort I

S

Figure 2.34 SDS Data Log Extractor screen

The software will display a continuous progress of the download status (figure 2.35). Note: since there
may a large number of files to download, this process may take several minutes to complete.

€3 SDSE0XE Data Downloader oy ] 4

File Options

sDs: |[1 92.168.1.217] 551 Model 5052020 Datalogger SW SDS 505000

File: datalogi. 341 alieady exiztz locally - zkipping.

File: datalog). 341 already exizts locally - skipping.

File: datalogk. 347 already exists locally - skipping.

File: datalogl. 347 already edizts locally - zkipping.

File: datalogm. 341 already exizts locally - skipping.

Downloading File: /B Alog2006./datalogn. 341 to C:A55150545D 5455055050004 og2006%datalogn. 341 [04./24./2006 1:00:00
PrA]

Downloading File: /E Aog2006/datalago. 341 ta C:AS5S0DSYS D550 55050004 0g20064datalogo. 341 [04/24/2006 2:00:00
PrA]

Downloading File: /B Aog2006,/datalogp. 341 to C:ASSASDSNSDSYSDS505000M og2006 datalogp. 341 [04,/24,/2006 3:00.00
PrA]

Downloading File: /B Alog2006./datalogg. 341 to C:A551A5055D 555055050004 og20064datalogg. 341 [04./24/2006 4:00:00

ikl

B

Download I

N\

Figure 2.35 SDS Data Log Extractor download progress

When all of the files have been downloaded, the words “Operation Complete” will be at the bottom of the
list, and the button at the bottom will read "Download”. A message box will also be displayed reading
“Operation Complete”. Clicking on the OK button on the message box will close down the download data
screen.

Clicking on the “Abort” button will stop the download and close the SDS Data Log Extractor screen. Any
files that have already been downloaded will not be erased. The next time the user wishes to download
survey data from the same device, the files that have already been downloaded will be skipped and not
be downloaded again.

The Drive menu option will allow the user to select the drive on the datalogger to download data from.
The choices are Eor A (Troubleshooting Only). The E drive is the default location for logged data, but
sometimes when there is an issue with the E drive, the datalogger will begin to log data to the A drive.
The most common issue with the E drive is that the flash card is not firmly secured in its socket.
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SDS - Launch Direct FTP

The Launch Direct FTP tool is used for administrative purposes. If you wanted to clean up old data
log files, this tool will allow you to perform this action. Only data stored in the E folder should be
manipulated or removed. The Launch Direct FTP menu option will start a new FTP session. This will
open a new window that displays all of the files and directories on a specific SDS instrument (figure
2.36).

B3 fip://192.168.1.91/ - Microsoft Internet Explorer — =] =]
File Edit ‘lew Favortes Tools Help |
d=Eack - = - | ‘Dysearch hiFoiders o | [N 05 < cew | EE-

Address [(&1 Frpi/152.165.1.917 =] oo |Links |
o = Eq

a = ID_CoDE index.zhtml  SSI_logo_z...

192.168.1.91

sssssssssss

Click here o learn about brovesing FTP
sites,

E

[User: 551 [ Internet
Figure 2.36 FTP session window with Windows Explorer

Please note that if Microsoft Internet Explorer 7 is installed on the computer, then the ftp session window
will be displayed as a link-style, instead of the folder-style. If only Internet Explorer 6 or earlier is
installed, then the ftp session window will be in a folder-style window. If Internet Explorer 7 is installed,
it is possible to open the ftp session in a folder-style window. Click on the Launch Direct FTP menu
option, then with Internet Explorer 7 open, click on the Page button in the top right of the screen and
select the option Open FTP Site in Windows Explorer (figure 2.36b). This will open a folder-style window.
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= FTP root at 192.168.1.211 - Windows Internet Explorer

ey - [Blrunmiszaenaziar =) (] [><]] [ 2=
3 & [ @@rreroot st 1921681 211 T 5 - E) - A= - [reage - @FTools - 7

F1P root at 192.168.1.211

To view this FTP site in Windows Explorer. click Page. and then click Open FTP Site in Windows Explorer.

Figure 2.36a FTP session window with Internet Explorer 7

R - B - &= | B

M Windows Chrl4-M

Save &S, ..

Send Page bw E-mail. ..

Send Link byw E-mail. ..

Edik wikth Microsoft FronktPage

Zoarm
Texk Size [ 3
Encoding

Wiews Source

Cpen FTP Sikte in Wind = Explarer

Figure 2.36b — Open IE7 FTP site with Windows Explorer

The version of Internet Explorer can be found in the Help — About Internet Explorer menu option of
Internet Explorer. Note: if the SDS - Multiple SDS Mode menu option is checked, then the software will
display a selection box for the user to select which SDS instrument to FTP into (figure 2.37). See the
section “"SDS - Multiple SDS Mode” for a more detailed explanation of the Multiple SDS Mode menu
option.

Choose a Device

=]
I['I 92.168.1.91]1 551 Model SD58040 Datalogger SH 505505000 ;I

Cancel_|

Figure 2.37 SDS instrument selection box
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Clicking the “OK” button will open the FTP window. Clicking the “Cancel” button will cancel the FTP
session creation. If the Multiple SDS Mode menu option is not checked, the software will start an FTP
session with the first SDS device that is found on the network.

FTP Login For Access to the A Drive

To gain access to the A drive on the SDS instrument, enter the following text in the address bar on
Internet Explorer 6 or earlier, or open up the My Computer icon and type the following into the address
bar if Internet Explorer 7 is installed:

ftp://LANG:SSI1772@<IP Address>

where <IP Address> is the IP address of the SDS instrument. For example, if the IP address is
192.168.1.202, then the text would look like: ftp://LANG:SSI1772@192.168.1.202 (Figure 2.39). Note —
The username of LANG and the password of SSI772 must all be capitalized in order for the login to be
successful. If the username or the password is not capitalized, the user will receive a message box
requesting login information, which will not log the user in (figure 2.38).

Could not login ko the FTP server with the user name and
password specified.

FTF Serwver: 192,165.1.202
User Mame: I ;I
Password: |

After wou login, wou can return ko this FTP server easily
by adding it to wour Favorites Lisk,

[ Login Anonymously | Sawve Password

Laogin I Cancel

Figure 2.38 Re-login message box

E 551 Intranet - Home - Microsoft Internet Explorer Jﬂﬂ

Fle Edt View Favortes Toos Help i
AL A @ A ‘ @Search 3 Favorites @Media @ ‘ % ElER

hdress | fip:LANG:SST772@19%2, 1661, 202 v @Gn Links

Figure 2.39 FTP login information in Internet Explorer’s address bar

Once the user has been successfully logged in, the user will have access to the A drive. Any language file
that will be placed on the SDS instrument needs to be located on the A drive.
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SDS - View Real-time Data

2 Current Trends - 192.168.1.217

v a|u|9e| v
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TC1T 27 600 =
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» Time
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Figure 2.40 Real-time Data screen

The View Real-time Data menu option will display the most current real-time data available. This screen
will update itself with the most current real-time data every 60 seconds. The amount of time left until
the next update will be displayed in the bottom left-hand corner of the screen. When it does update, the
software will connect to the SDS, download the data, and re-draw the screen. Any screen settings, such
as the size of the graph and how zoomed in the user is, will not be changed. Note: if the Multiple SDS
Mode menu option is checked, then the SDS software will display a device selection box that will allow
the user to choose which device to gather the real-time data from (figure 2.37). If the Multiple SDS
Mode menu option is not checked, then the SDS software will gather real-time data from the first SDS
device that it finds on the network. Note: it is possible to view real-time data from more than one SDS
instrument at a time. To view multiple real-time data, click on the View Real-time data menu option
again and select the next SDS instrument.

* Cursor Button

This is the default cursor used on the screen. The user can select the various TCs to plot and move the
scrollbar on the left side of the screen up or down in order to see more TCs.

GK Zoom Button

This will allow the user to zoom in the graph of the real-time data. Once the cursor is over the graph it
will change to a crosshair, +. The user can then hold down the left mouse button and drag the cursor to
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highlight the section of the graph that is to be enlarged. Letting go of the mouse button will enlarge the
graph.

@ Pan Button

This will allow the user to pan to a different part of the graph. Once the cursor is over the graph, it will

change to a crosshair with arrows, & By holding down the left mouse button and moving the mouse
left, right, up, or down, the user can move the scale of the graph by minutes or temperature, or both.

Q Refresh Button

This will refresh the graph and reset the graph’s display values to their default values. For the values
along the y-axis, the refresh sets the range from 0 to 2400. For the minutes along the x-axis, the refresh
encompasses approximately two hours. Note: when the Real-time screen first loads up, the graph
encompasses roughly one hour of data. The graph is marked with fifteen-minute intervals along the x-
axis.

‘-:'1 Print Button

This will create a print preview of the graph for printing purposes. When the user clicks on the Print
button, the Print Preview screen will be displayed (figure 2.41).

= prink preview gl =
& O - @00 B B B | close | Page | 1=

CEYEEUSEEENE
A5 AR F AR 7 5

iy

{ DNUNN Y CEN N EEAE
A7 3R 5 A2 7 A

Figure 2.41 Print Preview screen

From the Print Preview screen, the user can choose to zoom in on the preview by pre-defined
percentages (10% - 500%) or leave the zoom on the default setting (auto). The user can also determine
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how many pages to view at once (one, two, three, four or six). The default is one page. The upper
right-hand corner of the Print Preview screen contains a page counter, which will allow the user to select
which page to preview. Clicking on the “Close” button will close the Print Preview screen without printing
the chart. Clicking on the Print button (%) will print the document. Note: the Zoom function is for
preview purposes only and will not affect the actual print size. Once the document has been printed, the
user can close the Print Preview screen.

|

Real-time button

This button will allow the user to keep the cursor in a real-time mode, which will automatically update the
TC values on the left of the screen after every update. Clicking on this button will start the real-time
mode. Clicking on this button a second time will take the screen out of real-time mode. Note: The graph
will still continue to update once a minute, but the values on the left will no longer be up-to-the-minute
accurate.

The checkboxes under the “Plot” section will allow the user to determine which TCs to plot on the graph.
Checking a specific TC will display that TC's data on the graph. The data under the “Value” section is the
current temperature of the TC. Note: even if the Pan button or the Zoom button has been selected, the

user can still select or de-select the TCs. This will not affect the zoom status or the pan status.

SDS =2 Manage Survey Records

2 Manage Survey Records

Sl Remote SDSEM2 Survey Records

sSurvey Becords
1lz/4,2006 5:05 PM - Z:42 MM Default: [Buper Systems] ({SDETEENCH)

Muote: Hold shift or control to select multiple records.
Delete

Figure 2.42 Manage Survey Records — Local Survey Records Tab

The Manage Survey Records screen will allow the operator to delete survey records from the survey
database file either locally on the computer or remotely on the SDS data logger. The “Local Survey
Records” tab (Figure 2.42) will work with survey records saved locally to the computer. To select
multiple sequential records, hold down the Shift key and click on the desired survey records. To select
non-sequential records, hold down the Ctrl key and click on the desired survey records. The operator will
have to confirm the deletion by clicking on the “Yes” button on the message box (Figure 2.43).
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Delete local records? X

\_:.P Are you sure you wank to delete the selected records from the local database?

w |

Figure 2.43 Confirm delete of local records

= Manage Survey Records

Local Survey Records  Femate SDSE0K Survey Records

Survev Records [192.168.1.207] 551 Model 5058040 Datalogger SN SDSTEEMC i Load
sUney Records

Mate: Hold zhift or control to select multiple records.

Figure 2.44 Remote SDS80xx Survey Records Tab

The “"Remote SDS80XX Survey Records” tab (Figure 2.44) will allow the operator to delete survey records
directly from the SDS data logger. The drop-down list at the top of the screen will list all of the SDS data
loggers found on the network. Note — the drop-down list may take a few moments to search the network
for SDS data loggers. Note — Currently, the drop-down list will also be populated with Video Recorder
dataloggers. Please use caution when selecting a datalogger from the list; deleting data from a Video
Recorder could produce undesirable consequences. When the operator has selected the correct data
logger, he/she can click on the “Load” button to load the survey data. To select multiple sequential
records, hold down the Shift key and click on the desired records. To select multiple non-sequential
records, hold down the Ctrl key and click on the desired records. Clicking on the “Delete” button will
remove the survey records from the list. Note — The survey records will be removed from the list, but not
actually deleted from the SDS data logger until the "Save Changes” button has been clicked. If one or
more survey record is accidentally deleted, click on the "X” in the top right of the screen to close the
screen down, and start over. Clicking on the “Save Changes” button will save the changes back to the
SDS data logger. No confirmation is needed for this action. Once the changes have been saved, a
message box will be displayed (Figure 2.45).
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Saved. E|

\!J‘) Your changes have been saved,

Figure 2.45 Changes Saved message box

SDS 2 Perform Comms Test
SDS - Perform Comms Test

The Perform Comms Test menu option will send out a broadcast over the network to determine if any
SDS instruments are located on the network. If an instrument is located on the network, the software
will attempt to ping the device. This function will let the user know if communication with an SDS
instrument through the SDS Reporter software is possible. When the test has finished, one of three
options will happen:

1. No SDS found

No SDS instruments were found on the network. Check the network connections. A message
will be displayed to the user (figure 2.46). Click the "OK" button to close the form

Testing Comnmmun i |

Testing Communications - Please Wait...

Qluerying Metwark for SDS..

Mo SDS Found =]

@ Could nok find any S0S on the nekbwork

Figure 2.46 No SDS found on network message

2. One or more SDS were found.

One or more SDS instruments were found on the network, and all responded to the ping. A
message will be displayed saying (figure 2.47).

Comms OK

Figure 2.47 Communications OK message

Super Systems Inc. Page 65 SDS Data Logger Manual #4565 Rev D



'

)

This means that all communications appear to be ok (figure 2.48). Click the “Close” button to
close the form.

Teskting Communications... |

Testing Communications - Please Wait...

Quernving Metwork, for SDS...
Found SDS at IP: 192.168.1.202 | attempting to ping it.
The SDS replied to ping successfullp [0 mzec)
Found SDS at IP: 192.168.1.207 . attempting to ping it
The SD5 replied to ping zsuccessfullp [0 mae
=

Close I

Figure 2.48 Communications ok message on Test Comms dialog box
3. One or more SDS were found, but one or more failed to respond to a ping.

SDS instruments were found on the network, but one or more did not respond to a ping. For
each instrument that does not successfully respond to the ping, the user will be informed that
there was a problem testing the communications and the software will give the IP address of the
SDS instrument(s) that failed to respond as well as the IP address of the SDS instrument(s) that
did respond successfully to the ping (figure 2.49). The most common cause is different subnets
between the SDS and the computer (figure 2.50). The user may need to change the IP address
of the SDS through menu option 26, Set IP Address. Click the “Close” button to close the form.

Testing Communicaktions... e |

Testing Communications - Please Wait...

Querying Metwork for SDS ..
Found SDS at IP: 192.168.0.202 . attempting to ping it
The 505 did not reply to a ping.. Check your network configuration]

Cloze I

Figure 2.49 One or more SDS did not respond message on Test Comms dialog box

Communications Problem Detected. X

The SDS at IP 192,168.0.202 Failed ta respond to a ping request. The mast common cause is that the computer and
303 are on different subnets, Please check ko make sure the IP address of the 503 is compatible with this computer,

Figure 2.50 One or more SDS did not respond message

If the user is attempting to communicate with the SDS directly using a laptop that also has a
wireless network on it, the wireless network could interfere with some of the SDS Reporter
functions. The UDP error could happen if the user tried to ping a datalogger while a wireless
network was enabled (figure 2.50a). Any wireless network should be disabled before running
the SDS Reporter software.
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SDSReporter

The UDP Broadcast timed out.

The mast camman cause for this is having a wireless netwark connection enabled while being connected to the SDS, Please go to contral panel - = Nebwork
Connections, and right click - = disable any wireless network connections,

Anaother possible cause is firewall | antivirus software preventing the communications,

Figure 2.50a UDP Error

Options Menu Options

Options &> Multiple SDS Mode

This is a toggle switch for the application. If there are multiple SDS instruments located on the network,
click this menu option. Once clicked, there will be a check mark next to the menu item. If this menu
option is not checked and there are multiple SDS instruments on the network, the software will use the
first SDS device that is found. This menu option is checked by default.

Options 2> Show Labels On Chart

This is a toggle switch for the application. When checked, this will display the “Begin Survey” label for
the survey on the real-time graph (figure 2.51).

Beqin Survey

Figure 2.51 Label from real-time graph

Help Menu Options

Help > Check for Updates

The Check for Updates menu option will check for updates over the Internet and automatically update
the SDS firmware and software. If an update is found, the software will display a message box asking
the user for update confirmation (figure 2.52).

SDSReporter Automatic Updates

Figure 2.52 Update found message box
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The software will automatically update the files and restart the application (figure 2.53)

AutoUpgrade
ES¢ Automatic ‘

@ AsutoUpgrade is upgrading local application files,

Downloading Axlnterop. CWUIControlsLib. dll

| | Cancel I

Figure 2.53 Automatic Update screen

If no updates are available, then the software will display a message box informing the user (figure
2.54).

SDSReporter Automakic Updaf x|

@ Mo updates are available at this time.

Figure 2.54 No updates message box

Help > About

The About menu option displays the SDS Reporter version that is running, and all of the previous versions
with any version notes (figure 2.55).
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About SDSReporter

Application Yerzion: 1.707.0.51
Patch Motes

delete data after it haz been downloaded. S

-Added a test comms option to the S05 menuw. The test comms window will do a broadcast for all 505,
and do a test ping on each of them.  One of three things will ocour:

1] Mo 505 found uszer iz informed no 505 rezponded to the broadcast

21 1 ormore 505 were found, and all succeszsfully rezponded to a ping the user iz informed
that all comms seems akaw.

3 1 ormore 505 were found, and one or more failz to rezpond to a ping for each 505 that
doesnt successfully respond, the uzer will be informed that there wasz a problem testing communications,
and be given the |P address of the 505 which failed ta rezpond. The uger will alzo be informed that the
most common cause iz differing subnets between the 505 and the computer.

-Uzerz should nio longer be able to select a zureey start time that iz earlier then the survey end time [f
they pick the times in the wrong order, the start and stop times will just fip spotz with each other.

Werzion 1.107.0.50

Date: 12/1/06

-Dates and Furnace information added to TC data printout.
-Other zmall bug fixes.

Werzion 1.1071.0.51

Drate: 12/7/08

-Added patch notes to the About dialog.

Cloze

Figure 2.55 SDSReporter About box
SDS Data Tags

SDS Data tags are created so that all of the template information and survey data can automatically be
used for the report process. Data that is captured during the survey is summarized to provide the overall
results for the report. This can be in the form of a graph, tabular data, text, etc. Data tags have been
specifically created to address the uniformity requirements for AMS and other standards. We have tags
that address, overshoot, minimum TC with value, maximum TC with value, trend data, tabular data, etc.
An example of an output from the data tags can be seen by opening the Example report from the SDS
Recorder provided with the installation. The only data not generated from data tags is the tabular print
out of the actual temperatures. This data is generated from the Survey TC Data option and will print all
data points that are displayed on the graph between the “start” and “stop” selected by the user in the
survey.

In the figure below (Output From Data Tags), you can see and example of the data tags for the graph,
survey setpoint, minimum and maximum TCs with values and deviation. The data tags used to generate
the information below are;

<SDS:GRAPH600x400>

Super Systems Inc. Page 69 SDS Data Logger Manual #4565 Rev D



TC Survey Summary

Minimum TC number:

#mten#

Maximum TC number:

#xten#

Minimum TC Value: #mtcv#

Maximum TC Value: #xtcv#

Min deviation from setpoint: #md# | Max deviation from setpoint: #xd#
4o |
i L15PM
TC Survey Summary

| Minimum TC number: 6 | Maximum TC number: 3

Minimum TC Value: 77.8 | Maximum TC Value: 418.7

Min deviation from setpoint. -272.2 | Max deviation from setpoint: 68.7

Figure Output From Data Tags

Tag Description Usage
SDS:FILE The filename the report is saved as <SDS:FILE>
SDS:PD The current date when the report is printed <SDS:PD>
SDS:PT The current time when the report is printed <SDS:PT>
SDS:FID The furnace ID <SDS:FID>
SDS:FM Furnace make/model <SDS:FM>
SDS:FT Furnace type <SDS:FT>
SDS:FU Furnace use <SDS:FU>
SDS:FD Furnace dimensions <SDS:FD>
SDS:FC Furnace Class <SDS:FC>
SDS:FOR Furnace operating range <SDS:FOR>
SDS:SD Survey date <SDS:SD>
SDS:ST Survey time <SDS:ST>
SDS:SDR Survey date range <SDS:SDR>
SDS:DUR Duration of the survey <SDS:DUR>
SDS:0P Operator. Survey performed by <SDS:0P>
SDS:APP Survey approved by <SDS:APP>
SDS:TITLE The heading, or title, of the report <SDS:TITLE>
SDS:NOTE Notes for the survey <SDS:NOTE>
SDS:TOL Survey tolerance / uniformity required <SDS:TOL>
SDS:0TS Overtemp setpoint <SDS:0TS>
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SDS:SP Survey setpoint <SDS:SP>
SDS:TCN Number of thermocouples <SDS:TCN>
SDS:TCT Thermocouple type <SDS:TCT>
SDS:TCS Thermocouple spool number <SDS:TCS>
SDS:TCC Thermocouple calibrated by <SDS:TCC>
SDS:TCCD Thermocouple calibration date <SDS:TCCD>
SDS:TCCF Thermocouple spool correction factor <SDS:TCCF>
SDS:SDN Next survey due date <SDS:SDN>
SDS:SDSM Survey box make/model <SDS:SDSM>
SDS:SDSS Survey box serial number <SDS:SDSS>
SDS:SDSC Survey box calibrated by <SDS:SDSC>
Tag Description Usage
SDS:SDSCD Survey box calibration date <SDS:SDSCD>
SDS:SDSCF Survey box correction factor <SDS:SDSCF>
SDS:SPEC Specifications the survey meets <SDS:SPEC>
SDS:INT Sample interval <SDS:INT>
SDS:T Temperature character — F or C <SDS:T>
SDS:SIM Simulate load, in pounds <SDS:SIM>
SDS:0VS Overshoot (Deprecated) <SDS:0VS>
SDS:MIC Microns <SDS:MIC>
SDS:RES Survey result <SDS:RES>
SDS:GRAPH600x400  Inserts a 600X400 image of the graph <SDS:GRAPH600x400>
SDS:COM Company name <SDS:COM>
SDS:UDUR User defined survey duration <SDS:UDUR>
SDS:UTCN User defined number of thermocouples <SDS:UTCN>
SDS:PCT PID cycle time <SDS:PCT>
SDS:PDB PID dead band <SDS:PDB>
SDS:POL PID output limit <SDS:POL>
SDS:PPB PID PB (gain) <SDS:PPB>
SDS:PR PID rate <SDS:PR>
SDS:PRE PID reset <SDS:PRE>
SDS:CMF Temperature controller manufacturer <SDS:CMF>
SDS:CMA Temperature controller make/model <SDS:CMA>
SDS:IT Controller instrument type <SDS:IT>
SDS:TCG Thermocouple gauge <SDS:TCG>
SDS:0V Overshoot - yes or no <SDS:0v>
SDS:0D Outputs TC and temp if overshoot occurred <SDS:0D>
SDS:OVT Time the overshoot occurred <SDS:0VT>
SDS:CTD Inserts a note regarding the control <SDS:CTD>

Thermocouple. Inserts nothing if no control

Thermocouple was chosen
SDS:CTN Control thermocouple. Inserts “"None” if <SDS:CTN>

None is defined
°H# °degree type °H#
SDS:ED Survey end date <SDS:ED>
SDS:ET Survey end time <SDS:ET>
SDS:TCM Thermocouple map (image) <SDS:TCM>
SDS:UD1 User defined field 1 <SDS:UD1>
SDS:UD2 User defined field 2 <SDS:UD2>
SDS:UD3 User defined field 3 <SDS:UD3>
SDS:UD4 User defined field 4 <SDS:UD4>
SDS:UD5 User defined field 5 <SDS:UD5>
SDS:UD6 User defined field 6 <SDS:UD6>
Super Systems Inc. Page 71 SDS Data Logger Manual #4565 Rev D



SDS:UD7 User defined field 7 <SDS:UD7>
SDS:UD8 User defined field 8 <SDS:UD8>
SDS:UD9 User defined field 9 <SDS:UD9>
SDS:UD10 User defined field 10 <SDS:UD10>
SDS:UD11 User defined field 11 <SDS:UD11>
SDS:UD12 User defined field 12 <SDS:UD12>
SDS:UD13 User defined field 13 <SDS:UD13>
SDS:UD14 User defined field 14 <SDS:UD14>
SDS:UD15 User defined field 15 <SDS:UD15>
SDS:UD16 User defined field 16 <SDS:UD16>
SDS:UD17 User defined field 17 <SDS:UD17>
SDS:UD18 User defined field 18 <SDS:UD18>
SDS:UD19 User defined field 19 <SDS:UD19>
SDS:UD20 User defined field 20 <SDS:UD20>
Sample Output

Tag Sample Output

SDS:FILE SDSReportl.sdsreport

SDS:PD 2/16/06

SDS:PT 11:30:00 AM

Tag Sample Output

SDS:FID Batch 1

SDS:FM Furnace Mfg.

SDS:FT Batch Gas Draw

SDS:FU Temper

SDS:FD 24x15x 12

SDS:FC A

SDS:FOR 650 - 1000°C

SDS:SD 2/16/06

SDS:ST 11:30:00 AM

SDS:SDR 2/13 THRU 2/14

SDS:DUR 00:30:00

SDS:0P Shaun Scott

SDS:APP Scott Brown

SDS:TITLE Test Survey 1

SDS:NOTE This is a test survey

SDS:TOL [+/-]110

SDS:0TS +10

SDS:SP 750

SDS:TCN 20

SDS:TCT K

SDS:TCS 7458

SDS:TCC Soandso

SDS:TCCD 1/15/06

SDS:TCCF -1

SDS:SDN 2/28/06

SDS:SDSM SSI SDS8020

SDS:SDSS SDS60293201

SDS:SDSC Super Systems Inc

SDS:SDSCD 1/15/06

SDS:SDSCF -1.0

SDS:SPEC AMS 2750-C and D

SDS:INT 10s
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SDS:T F
SDS:SIM 500
SDS:0VS None
SDS:MIC N/A
SDS:RES Passed
SDS:GRAPH600x400 [An image of the graph]
SDS:COM Company Name
SDS:UDUR 30 mins
SDS:UTCN 20
SDS:PCT 20
SDS:PDB 2
SDS:POL 2
Tag Sample Output
SDS:PPB 2
SDS:PR 2
SDS:PRE 2
SDS:CMF Super Systems
SDS:CMA 7EK
SDS:IT B
SDS:TCG 16
SDS:0V Yes
SDS:0D TC6 - 1700°
SDS:OVT 5:30
SDS:CTD TC5 is the control TC, and is not used in uniformity survey
results
SDS:CTN TC5
off °F
SDS:ED 2/16/06
SDS:ET 11:30:00 AM
SDS:TCM [Thermocouple image]
TC Offsets
Tag Description Usage
#ol# Offset for TC1 #ol#
Tag Sample Output
#ol# -1
Min/Max/Mean/Spread/Deviation
Tag Description Usage
#nl# Minimum temp for TC1 within the selected #nl#
Survey region. Substitute numbers for other
TCs
#x1# Max temp for TC1 #x1#
#ml# Mean temp for TC1 #ml#
#s1# Spread for TC1 #s1#
#vnl# Deviation @min temp from setpoint for TC1 #vnl#
Tag Description Usage
#vx1# Deviation @max temp from setpoint for TC1  #vx1#
#vml# Deviation @mean temp from setpoint for #vml#
TC1
#mten# Minimum TC number #mtcn#
#mtan# Minimum TC number during approach #mtan#
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segment
#mtav# Minimum TC value during approach segment #mtav#
#mtcv# Minimum TC value #mtev#
#mtex# The maximum temperature of the minimum  #mtcx#
TC
#md# Minimum calculated survey TC absolute #md#
deviation from setpoint
#rect# Recovery Time — the time between the time  #rect#

when the first TC comes into tolerance and
the time when the last TC comes into tolerance

#xten# Maximum TC number #xten#

#xtan# Maximum TC number during approach #xtan#
segment

#xtav# Maximum TC value during approach segment #xtav#

#xtem# Minimum temperature of the maximum TC  #xtcm#

#xtcv# Maximum TC value #xtev#

#xd# Maximum calculated survey TC absolute #xd#

deviation from setpoint

Tag Sample Output
#nl# 183
#x1# 183
#mil# 183
#s1# 12.5
#vnl# 383
#vx1# 383
#vml# 383
#mtcn# 2
#mtan# 2
#mtav# 150
#mtev# 1
#mtex# 500
#md# 201.0
#rect# 3 mins 30 secs
#xten# 1
#xtan# 6
#xtav# 1500
#xtem# 500
#xtev# 183
#xd# 383.0
#ts# 13.8

Creating a Personalized Template

To create a personalized template, the user needs to open a Word document and save it to the
“ReportTemplates” folder in the main installed folder as a Rich Text Format (.rtf) file. Any of the SDS
data tags listed in the above section can be used to create a company-specific template. For example,
suppose that someone wanted to create a simple template called "NewTemplate” which displays the
current date and time the report is printed, the company name, the title of the report, the number of
thermocouples used, and the results of the survey. First, the user would open a Word document and
save the file as "NewTemplate.rtf” in the “ReportTemplates” folder in the main installed folder. Next, the
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user would set up any initial formatting settings, such as margin sizes, page layout (portrait or
landscape), etc. Now, the user can set up the template to his or her company’s specifications. Suppose
that the current date and time will be in the top right corner of the report and should be 10-point Arial
font. On the first line, the user can select the right-justified option, the 10-point font size option, and the
Arial font option. This will leave the cursor in the top right corner. Next, the user will enter the following
exactly (including the brackets): <SDS:PD>. This will be where the current date is displayed. On the
next line, the user can enter <SDS:PT>. This will be where the current time is displayed. Now suppose
the title of the report should be centered, bold, 14-point Arial font. The user will select the center-
justified option, and the 14-point font size option. This will place the cursor in the middle of the line.
The user will then enter <SDS:TITLE>. The rest of the report - company name, number of
thermocouples used, and the results of the survey - can be left-justified, non-bold, 12-point font. On the
next line, the user will select the left-justified option, the 12-point font size option, and deselect the bold
option. The user can then enter: Company name: <SDS:COM>. On the next line the user can enter:
Number of thermocouples used: <SDS:TCN>. On the next line, the user will enter: Survey results:
<SDS:RES>. Next, make sure the document is saved and close the document out. Note: it is always
good practice to save a document in progress often in case of power failure. The resulting template
should resemble figure 2.56 below.

il NewTemplate.rtf - Microsoft Word ==l
JEiIe Edit Wiew Insert Format Tools Table Window Help

I EIETR S = .@?“Normd - anal iz B rul=sE=sEEEsEO-A- 2
FMEHEEIERH IR

I

=305 FPD=
<3053 PT=
<SDS:TITLE>
Company name: <SDS COM=
. Mumber of thermocouples used: <SDSTCHN=
- Survey results: =SDSRES=

Figure 2.56 Completed NewTemplate report template

Next, the user will select the report template to use from the SDSReporter application’s Open option.

Clicking on the Open button, , hext to the Report Template field will allow the user to choose which
report template to use (figure 2.3). The user can choose the NewTemplate.rtf file. Next, the user will
choose the “Export to RTF” print menu option on the File menu and choose the location to save the .rtf
file. The actual report should resemble figure 2.57 below.
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u_E. NewTemplateReport.rtf - Microsoft Word

JEiIe Edit Wiew Insert Format Tools Table ‘window Help
=2 === N R Y =
o

-2 7
EENS e

J Mormal

1 10 12 e

- Arial

Test Report - Tim Kell
Company name. SSi

02/21/06

MNumber of thermocouples used: 16
Survey results: Passed

Figure 2.57 Actual NewTemplate report
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SDS Template Manager

SDS Reporter Versions 1.101.0.71 and below

The purpose of a template is to save the users time by filling in some of the more generic survey data.
For example, the user could create a template for one customer, including company name, TC type, efc;
then when the survey is run using this template, this information is already present and it won't need to
be entered for each survey run for that customer. The SDS Template Manager (figure 3.1) allows the
user to see all of the templates currently stored on the SDS instrument, as well as any templates saved to
a local computer. The Template Manager also allows the user to create new templates and save them to
a local file on a computer or network, or to the SDS instrument.

F®sDs Template Manager o ) e

File Device

_1|-__'?|L‘all

Template Infarmation | Survey Information I AuctiveTCs I Contraller Information I

— Templates

Template/Test Mame: I Setpoint: I
Company Mame: I Simulated Load [|bz]: I

Murnbeer of TCs: |2D
I—

TC Type:

TC Spoaol SH: I

TC Spoal Correction: I

MHotes: I

Add Mew Save Changes Delete
Template to Template Template

Save File |

Device connected: [M ot Connected |

Figure 3.1 SDS Template Manager

Description/Function of Template Manager Screen buttons/menu options

This section will describe the function of the toolbar buttons and menu options for the Template Manager
Screen. Clicking on either the form button or the menu option will produce the same result, so each pair
of button/menu option will be explained in this section.

New Button / File > New

The New button, —1 , or New menu option will allow the user to create a new set of templates. The

maximum number of templates that can be added per file is 32. Note: initially, there are zero (0)
templates. The SDS software does not create 32 blank templates. When the New Button is clicked or
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the New menu option is clicked, the tabs that contain all of the fields for the template will become visible,
as well as the Templates list. Creating a new template file will also enable the Save menu option and the
Save As menu option. Using the keyboard shortcut Ctrl + N will also create a new set of templates.

Open Button / File  Open

The Open button, “<, or the Open menu option will allow the user to open an existing template file
either from the local computer, or from an SDS instrument on the network. Note: Before clicking
“Open”, the user must first select the device to open from the Device menu option (“Local File” or “"SDS
Instrument”) (figure 3.2).

™ s0s Template Manager L =] =]

File | Device
w Local Fie
J

SDS Instrunent

Cresvece cormmnchad: Il ocal File

Figure 3.2 Device menu option

Once selected, the chosen device will have a check mark next to it on the Device menu option. The
“Device connected:” label at the bottom of the Template Manager screen will also show what device the
user is connected to (either “Local File” or “"SDS Instrument”). When the user is not connected, this label
will show “Not Connected”. If the user tries to open a file without selecting a device first, the SDS
software will display a “"No Device Type Chosen” message (figure 3.3).

Mo Device Type Chosen |

& Please choose a device type before opening!

Figure 3.3 No Device Type Chosen message

If the user selects a local file, the SDS software will display a common Windows dialog box for the user to
select which file to open. If the user selects an SDS instrument, the SDS Software will display a selection
box with all of the available SDS instruments on the network (figure 3.4). Note: Since the SDS software
is searching the network for all SDS devices, it may take a couple of minutes for the selection box to be
displayed.
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Cancel | OF. |

Figure 3.4 SDS Instrument selection box

While the SDS software is searching the network for SDS devices, it will display a progress box, which will
detail the progress of the search (figure 3.5).

File successfully downloaded to C: Templ: |

File successfully downloaded to
C:ATemplateshT empFileFrogrammer.tm
p

Figure 3.5 SDS software progress box

When the software is finished searching, the progress box will close automatically. When the Open
Button or the Open menu option is clicked, the tabs that contain all of the fields for the template will
become visible. Opening an existing file will also enable the Save menu option and the Save As menu
option. Using the keyboard shortcut Ctrl + O will also open an existing file. Once the file has been
loaded, the filename will be listed above the Templates list on the right of the form (figure 3.1).

Save Buttons / File » Save

The Save button, = , Save File button, or Save menu option will allow the user to save the current file
back to the local machine or the SDS instrument, depending on which device was selected. Note: this
option will only save the entire file back; it will not save changes to individual templates. Any changes
to the individual templates that have not been saved will not be saved. See the section “Save
Changes to Template Button” to find out how to save changes to individual templates. If the user selects
an SDS instrument, the SDS software will display a progress box (figure 3.5). When the save has
completed, the SDS software will close the progress box. Once the file has been saved, the filename will
be listed above the Templates list on the right of the form (figure 3.1).

File & Save As

This option acts the same way as the Save option, only it will display a dialog box or SDS selection box
(depending on the device selected) that will allow the user to select the file to save. If the user selects
“Local File” as the device, the SDS software will display a common Windows dialog box. Clicking “Cancel”
will cancel the save. If the user selects a file that already exists and clicks “Save”, the SDS software will
prompt the user for overwrite confirmation (figure 3.6). Clicking “"No” will close the confirmation box
without saving and return the user to the Save As dialog box. Clicking “Yes” will save the file.

Cih Templates Tests, bt already exists.
Do you wank ko replace ik?

Super Systems Inc. Page 79 SDS Data Logger Manual #4565 Rev D



)

T :ﬁ(' I‘

Figure 3.6 Overwrite confirmation

If the user types in a filename that does not exist and clicks “Save”, the SDS software will prompt the
user for creation confirmation (figure 3.7). Clicking “"No” will close the confirmation box without saving
and return the user to the Save As dialog box. Clicking “Yes” will save the file.

=]

ZHTemplates\ My Test bxt does nok exist,
Do woa wank o creake kY

Figure 3.7 Creation of a file confirmation

If the user selects an SDS instrument, the SDS software will display a progress box (figure 3.5). When
the save has completed, the SDS software will close the progress box. Once the file has been saved, the
filename will be listed above the Templates list on the right of the form (figure 3.1).

Exit Button / File & Exit

This option will close the Template Manager screen.

The following buttons are located on the “Template Information” tab, “Survey Information” tab, “Active
TCs" tab, and the “Controller Information” tab, and deal specifically with individual templates, not the
template file as a whole. Clicking on these buttons will not affect the template file.

Add New Template Button

This option will add a template to the collection of templates stored in memory, up to 32 total templates.
The only required field is the Template Name. If the user attempts to create a template without

providing a template name, the SDS software will display a No Template Name error message (figure
3.8).

Mo Template Mame

Figure 3.8 No Template Name error message

The Setpoint field may be left blank or filled in with a numeric number up to 4 digits long. If the user
does enter non-numeric text, the SDS software will display a Setpoint Not Numeric error message (figure
3.9).
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Setpoint Not Numeric x|

& The setpoint musk be numeric or blank!

Figure 3.9 Setpoint Not Numeric error message

Once a template has been added, the first template will be loaded into the fields.

Save Changes to Template Button

This option will save the changes made to a specific template back to the template collection stored in
memory. A valid template must be selected from the “Templates” list to the right of the "Template
Information” tab (figure 3.10). Note: this will only save changes to 1 template at a time and it
will not save changes to the template file. Use the Save buttons or menu options to save the file.
Once the template has been saved, the first template will be loaded into the fields.

@SDS Template Manager o ] e
File Device
B | :ﬁfl Hl
Template Informatian | Survey Information | ActiveTCs | Controller Information | [ Templates
Irstrumnentd] et
Template/Test Name: |Defaul Setpaint: 1200 Template2
? ' paint. Template3
| Templated

Company Mame: Simulated Load [Ibz]: 500

Murnber of TCx: |4|:|
TC Type: IE

Figure 3.10 Templates drop-down list

If a valid template is not chosen, the SDS software will display a No Template Selected error message
(figure 3.11).

Mo Template Selected x|

& & walid kemplake must be selecked!

Figure 3.11 No Template Selected error message
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Delete Template Button

This option will delete a template from the collection of 32 templates stored in memory. Note: the first
template cannot be deleted. If the user attempts to delete the first template, the SDS software will
display an error message (figure 3.12).

Unable To Delete First Template

Figure 3.12 Unable to Delete First Template message

Once the user clicks on the “Delete Template” Button, the SDS software will display a message
confirming the delete (figure 3.13).

Confirmn Template Delete

Figure 3.13 Confirm delete message

Clicking on “No"” will cancel the delete. Clicking on “Yes” will delete the template. After the deletion has
occurred, it will not be necessary to click the "Save Changes to Template” button.
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Description of Template Manager Screen Tabs

Template Information Tab

ESDS Template Manager

_ 1]
File Device

jl:_;'i‘flddl

Template Infarmation ISuwe_l,J Information | ActiveTCs | Controller Infarmation | - Templates

Instrument3T . kat

Template/Test hame; IDEEE'UIt Setpaint. 1200 1:%5::{:%
Company Mame: ISSi Simulated Load [lbs]: IEDD Templated
Mumnber of TCs: I4|j

TC Type: IE

TC SpolSN: 78546

TC Spool Correction: |'2

Motes: IThis iz the default test template.

Add Mew Save Changes Delete
Template to Template Template

Save File |
Device connected: [ acg| File

Figure 3.14 Template Information tab

This tab contains general information about the template such as the Template Name, the Company
Name, the Number of TCs, the TC Type, the TC Spool Number, the TC Spool Correction, the Setpoint, the
Simulated Load in pounds, and any Notes about the template. This tab also contains the 3 template

buttons: Add New Template, Save Changes to Template, Delete Template. See “Description of Template
Manager Screen Fields” for the maximum number of characters allowed per field.
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Survey Information Tab

¥ sDs Template Manager - =] x|
File Device
B |_..r’| ﬂdl
Template Information Survey Information |.-’-‘n.ctiveTEs Enntrollerlnformationl . Templates
Instrument3T kst
~Suvegifomaton
_ Template2
Survey Duration: |3EI Minutes Sarmple Irterval: I-IEl j‘ Seconds }Emplatei
emplate
5 Tal ) i
urvey Tolerance [+ [10 Operaior 1M kel

Specification: IGBH AR9E-B

r—Furmnace Information

Furnace 10 |Batch3 Temp Type: IC 'I [*F or °C)
I. - I
MakeMadel |Furnace Mg Range: 350-1000
SEn Type: |Eat-:h Gas Draw
Dimensions: I HleH e IBatch

Add Mew Save Changes Delete
Template to Template Template

Save File |
Device conmected: [ qzal File

Figure 3.15 Survey Information tab

This tab contains information about the survey such as the Survey Duration in minutes, the Survey
Tolerance, the Specification the survey meets, the Sample Interval in seconds, and the Operator
performing the survey. It also contains information about the specific furnace involved such as the
Furnace ID, the furnace’s Make and Model, the furnace’s Dimensions, the Temperature Type used in the
furnace (Fahrenheit or Celsius), the Temperature Range of the furnace, the Type of furnace, and what
the furnace is used for. This tab also contains the 3 template buttons: Add New Template, Save Changes
to Template, Delete Template.
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Active TCs Tab

EESDS Template Manager : o =] |

File Device

:

5 =]

Template Infnrmationl Survey Infarmation ActiveTCs | Cantraller Infarmation

— Templates

Irstrurnent3T bt

SDS Type Template2
(SDS aonzo 505 8040 ¥ Template3
Templated

Use these active TC setiings W TC Gauge: |25_

Board &

1 V2 W 3w 4 ¥ 5 ¥ AW 2 W 23 M4V 5V
Board 2 Board B

E M 7 W 8 ¥ 3 ¥ 10 ¥ % 27 [ 281 23 [ a0 [T

" o120 1210 14 18 [T N 2 = xaC =1

16 17 [ 18 [0 19 20 O ¥ [ 2 23 40

Add Mew Save Changes Delete
Template to Template Template

Save File |

Device connected: (| qcal File

Figure 3.16 Active TCs Tab

This tab contains information about the active TCs such as the type of SDS instrument involved (8020 or
8040), the Gauge of the TC, and a check box for each of the TCs. There is also a check box to allow the
user to use the active settings for the TCs or to individually select the TCs to use on the SDS instrument.
Checking “Use these active TC settings” will set the checked TCs and will enable either the first 20 check
boxes, or all of the check boxes, depending on what type of SDS instrument is selected. Leaving this
check box unchecked will not set any TC and will disable all 40 check boxes. This tab also contains the 3
template buttons: Add New Template, Save Changes to Template, Delete Template.
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Controller Information Tab

[®sps Template Manager =10 ]
File Device
R | __fl Hl
Template Infarmation | Survey Information | ActiveTCs  Cantioller Information [ Templates
Inztrurnemntd tat
— Temperature Controller [nformation
Template2
Contraller Mg ICDnlroIIer Mfa Template3
Templated
[R1258

Caontraller todel

—PID Settings

Cycle Time: |1 i}
Dead Band: |25|j[|

Clutput Lirnit: 450
PB(Gain}  [a000
Fiate: IF
Fieset: lw
Add New
Template

Save Changes
to Template

Delete
Template

Dievice connected: | ocal File

Save File |

Figure 3.17 Controller Information Tab

This tab contains information about the controllers such as the Controller Manufacturer, and the
Controller Make and Model. It also contains information about the PID settings such as the Cycle Time,
the Dead Band, the Output Limit, the PB (gain), the Rate, and the Reset. This tab also contains the 3
template buttons: Add New Template, Save Changes to Template, Delete Template.
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SDS Reporter Versions 1.101.0.76 and above

The purpose of a template is to save the users time by filling in some of the more generic survey data.
For example, the user could create a template for one customer, including company name, TC type, etc;
then when the survey is run using this template, this information is already present and it won't need to
be entered for each survey run for that customer. The new SDS Template Manager (figure 3.18) allows
the user to see all of the templates currently stored on the SDS instrument, as well as any templates
saved to a local computer. The Template Manager also allows the user to create new templates and save
them to a local file on a computer or network, or to the SDS instrument.

€= SDS Template Manager

Eil
2 || ||
<MNew Template>

Templates

Add Templats

| 4]

Figure 3.18 New SDS Template Manager

Description/Function of Template Manager Screen buttons/menu options

This section will describe the function of the toolbar buttons and menu options for the Template Manager
Screen. Clicking on either the form button or the menu option will produce the same result, so each pair

of button/menu option will be explained in this section.

New Button / File % New

The New button, —1 , or New menu option will allow the user to create a new set of templates. The
maximum number of templates that can be added per file is 32. Note: initially, there are no templates in
the file.

Open Button / File 5 Open

The Open button, ‘—j, or the Open menu option will allow the user to open an existing template file
either from the local computer, or from an SDS instrument on the network (figure 3.19).
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= Open Template File

¢ Open a local survey template file located on my computers

Lacal File

C:ASSMSDESurvepT emplateshTest tat Browse

7 Open a remote survey template file located on an SOS instrurment

Remote [S0S)
Select Instrument:

Scan
Cancel Open File |

Figure 3.19 Open template menu option

The use will be able to open a local template file or a template file that is on an SDS. If the user selects
a local file, the user will be able to click on the Browse button to select the file to open. The SDS
software will display a common Windows dialog box for the user to select which file to open. If the user
selects an SDS instrument, the SDS Software will display a selection box with all of the available SDS
instruments on the network. Note: Since the SDS software is searching the network for all SDS devices,
it may take a couple of minutes for the selection box to be displayed. This list will be populated with all
of the available SDS devices found when the “Open Template File” screen is first opened. Clicking on the
Scan button will allow the user to re-scan the network for available SDS instruments. Once a local or
remote file has been selected, click on the Open File button to open the file, or click on the Cancel
button to close down the screen without opening a file. Note: When the Open Button or the Open menu
option is clicked, the tabs that contain all of the fields for the template will not become visible — an
individual template must be selected to view the tabs. Once the file has been loaded, the filename will
be listed above the Templates list on the left of the form (figure 3.18).

Save Buttons / File » Save

The Save button, = , or Save menu option will allow the user to save the current file back to the local
machine or the SDS instrument. Note: Any changes made to any template will be saved at once when
this option is selected. Note: If the user is working with a new template file, the Save function will act
like the Save As function (see below section).

File & Save As

This option acts the same way as the Save option, only it will display a dialog box that will allow the user
to select the file to save (figure 3.20). This functionality of this screen is similar to the Open Template
screen (figure 3.19). The template file can be saved locally on a computer or remotely on an SDS
instrument. If the user selects to save the file locally, the user will be able to click on the Browse
button, which will display a common Windows save dialog box. The user will be able to select the
location and give the template file a name. If the user selects to save the file to a remote SDS, the
software will display a selection box with all of the available SDS instruments on the network. Note:
Since the SDS software is searching the network for all SDS devices, it may take a couple of minutes for
the selection box to be displayed. This list will be populated with all of the available SDS devices found
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when the “Save Template File As” screen is first opened. Clicking on the Scan button will allow the user
to re-scan the network for available SDS instruments. Once a local file or remote file has been selected,
click on the Save File button to save the file, or click on the Cancel button to close down the screen
without saving the file.

[ save Template File As...

' Save azurvey template file on the local computer
Local File

CASSHSDENS urvey Templatesh Templates. tat Browse

{7 Save a remote survey template fle to an SO5 instrument

Femate [SS)
Select Instrument;

192 168.1.217] 551 Model SDSB020 Datalogger SH 5DS0807115
[192.1681.216] 55| Model SD58020 Datalogger SM SD50807119
[192.168.1.219] 55| Model SD58020 Datalogger SM SD50807116

Scan
Cancel Save File

Figure 3.20 Save Template File As screen

The software will always display a message box with the success or failure of the save.
Exit Button / File » Exit

This option will close the Template Manager screen.

Add Template Button

This option will add a template to the collection of templates stored in memory, up to 32 total templates.
The only required field is the Template Name. The default template name is <Template Name>

Once a template has been added, the new template will be loaded into the fields.

Delete Button

This option will delete a template from the collection of 32 templates stored in memory.

Copy Button

This button will copy a template into the collection, assuming there are less than 32 templates already.
This would be useful if the user only wanted to change one or two items on the template, such as the
setpoint.

Arrow Buttons

The arrow buttons next to the Copy button will allow the user to change the order of the templates in
the file. This way, the more commonly used templates can be kept at the top of the file so the user will
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not have to scroll down to see the template on the SDS. The up arrow button will move the template up
one position, and the down arrow button will move the template down one position.

Description of Template Manager Screen Tabs

Template Information Tab

%= SDS Template Manager

Eil=

J|=|H
<New Template>
-~ Templates
Add Template | M
Template Information ] Survey Information ActiveTEs] Contraller Information

Template Name: ]Default

Compary K amme: 1supe' Systems

Furnace nformation

Fumace [D; |Batch #1 Temp Type: IF—‘
. |-350-1000
Make/Madel, |Fumacs Hfo. Range:

Type: Batch gas draw
Use: Batch
Furnace Class: 4l

Dimensions; |=2¢12¢10

Notes lThis iz the default template

T
Delete | Copy | J

Figure 3.21 Template Information tab

This tab contains general information about the template such as the Template Name, the Company
Name, furnace information such as the furnace ID, the make and model of the furnace, the furnace
dimensions, the temperature type (Fahrenheit or Celsius), the temperature range, the furnace type, the
furnace use, the furnace class, and any Notes about the template. See “Description of Template
Manager Screen Fields” for the maximum number of characters allowed per field.
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Survey Information Tab

CEX

%= SDS Template Manager
Fil=

MEIE
ASDF.ixt @ C:\SSi\SDS'\SurveyTemplates

-~ Templates

Add Template

Template Information  Survey Information ]ActiveTEs] Eontrollerlnformation]

Survey Information

Survey Duration: 30 Minutes Setpaint: 500}

Survey Tolerance [+7-]: 110 i THE.

Siulated Load (bsl: 1500 Specification: [aM3 2750 D

| Defaultt

T
Delete | Copy |J

Figure 3.22 Survey Information tab

This tab contains information about the survey such as the Survey Duration in minutes, the Survey
setpoint, The survey Tolerance, the Operator performing the survey, the simulated load, in pounds, and

the Specification the survey meets.
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Active TCs Tab

£ SDS Template Manager |Z]|E|EI
File:

Q=] -
ASDF.ixt @ C:\SSi\SDS'\SurveyTemplates

-~ Templates
Add Template

| Defaultt

Template Information] Survey Information  ActiveTCs ]Eontrollerlnformation

Thermocouples

Mumber of TCs: 110— TC Gauge: ’55—
TC Type: {K—
TC Spool 5t 11234
TC Spool Carechion: 2

Active Inputs

W Use these active TC settings

vl Input 3
vl Input 4
vl Input 5
vl Input &
vl Input 7
vl Input 8
v Input 9
v

| Input- 11 Sl

[>

T
Delete | Copy |J

Figure 3.23 Active TCs Tab

This tab contains information about the active TCs such as the number of TCs used, the Gauge of the TC,
the TC type, spool serial number, spool correction, and a check box for each of the TCs. There is also a
check box to allow the user to use the active settings for the TCs or to individually select the TCs to use
on the SDS instrument. Checking “Use these active TC settings” will set the checked TCs.
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Controller Information Tab

£ SDS Template Manager |Z]|E|EI

Fil=

MEIE
ASDF.ixt @ C:\SSi\SDS'\SurveyTemplates

-~ Templates
Add Template

Templatelnformation] Surve_l,llnformation] ActiveTCz  Controller Information

Temperature Contraller |nformation

Controller Mfg: Conbollerig:
Contraller tModel:  |R1286
Instrument Type |B

| Defaultt

PID Settings

Cyele Time: 110—‘
Dead Band: Iﬁ—
Output Limit; ]IF

PB(Gan}  [z000

Rate: 11 B0
Reset: 25000

T
Delete | Copy |J

Figure 3.24 Controller Information Tab

This tab contains information about the controllers such as the Controller Manufacturer, the Controller
Model, and the instrument type. It also contains information about the PID settings such as the Cycle
Time, the Dead Band, the Output Limit, the PB (gain), the Rate, and the Reset.
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Description of Template Manager Screen Fields

This section will describe the Template Manager screen fields and list any constraint for the fields.

Field Name
Template Name
Company Name
Furnace ID

Furnace Make/Model
Furnace Dimensions

Temp Type

Temperature Range
Furnace Type
Furnace Use

Furnace Class

Notes

Sample Interval

Survey Duration
Survey Tolerance
Simulated Load
Setpoint
Operator
Specification
Number of TCs

TC Type

Description

The name of the template
The company’s name
The Id of the furnace

The make/model of the furnace

The height, length, and width of the furnace

The type of temperature

(Fahrenheit or Celsius)

The low and high range of the furnace
The type of furnace being surveyed
What the furnace is used for

The class of the furnace

(Version 1.101.0.80 & above)

Any additional notes desired

The sample rate for the survey

(Version 1.101.0.71 & below only)

The duration of the survey in minutes
The survey tolerance/uniformity required
The simulated load in Ibs

The survey setpoint

The operator performing the survey

The specification the survey meets

The total # of TCs

The type of TC

Maximum # of Characters

22
40
17
22
15

1 (ForC)

10
20

15

63
61 for 1.101.0.76 & above

N/A

20

25
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TC Spool SN

TC Spool Correction

TC Gauge
Use Active TC
Settings
Check box 1 —
Check box 40

SDS 8020

SDS 8040

Controller MFG
Controller Model
Instrument Type
Cycle Time

Dead Band
Output Limit

PB (Gain)

Rate

Reset

Notes

The spool number
The spool correction factor
The gauge of the TCs

Use the active TC settings option

The active TCs for the survey

SDS 8020 instrument option
(Version 1.101.0.76 & Below)
SDS 8040 instrument option
(Version 1.101.0.76 & Below)
The controller manufacturer
The controller make/model
The type of the instrument
The PID cycle time

The PID dead band

The PID output limit

The PID PB (gain)

The PID rate

The PID reset

Version 1.101.0.71 & Below

18

N/A

N/A

N/A

N/A

18

18

e When the SDS 8020 option is selected, the SDS software automatically fills in *20” in the
“Number of TCs” field and Check boxes 21 through 40 (Boards 5 through 8) are disabled

e When the SDS 8040 option is selected, the SDS software automatically fills in "40” in the
“Number of TCs"” field and Check boxes 21 through 40 (Boards 5 through 8) are enabled

e When "20" is typed into the “"Number of TCs” field, the SDS 8020 option is automatically selected,
and Check boxes 21 through 40 (Boards 5 through 8) are disabled
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e When "40" is typed into the “"Number of TCs” field, the SDS 8040 option is automatically selected,
and Check boxes 21 through 40 (Boards 5 through 8) are enabled

General Notes
e Checking “Use these active TC settings” will enable the checkboxes

¢ Unchecking “Use these active TC settings” will disable all 40 check boxes. The TC check boxes
will still be checked, but the SDS instrument will not use these settings.
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Appendix A — Standard Calibration Range

Ranges used for the following thermocouples for certification are listed below unless otherwise specified
by the customer. Calibration and certification of the instrument are performed based on customer
specifications. For instrument calibration procedures, see section SDS 8020/8040 Data Logger — Keypad
Assignments — 22. Input Calibration and section SDS 8020/8040 Data Logger — Keypad Assignments —
23. Cold Junction Trim.

Thermocouple Type Range in °F
B 100 - 3300
C 32 -4200
E -300 - 1800
J -300 - 2100
K -300 - 2500
N -300 - 2300
NNM 32 -2500
R 32 -3200
S 32 -3200
T -300 - 750
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Revision History

Rev. Description Date MCO #
- Initial Release 06-08-06 N/A
A Updated SDS Download option (delete datalog files); | 01-12-07 N/A

Added SDS — Manage Survey Records menu option;
Updated Menu Option 34 — Clear Logged Data
(delete datalog files); Updated the SDS About
screen; Updated the Control TCs screen; Updated
Cold Junction menu screen (menu option 23); Added
new data tags

B Updated to reflect firmware revision 1.10 — New Cold | 01-31-07 N/A
Junction screen

C Updated New Cold Junction screen; Added “Analog 05-30-08 2060
Inputs” information; Updated SDS Reporter menu
options; Added “Appendix A — Standard Calibration
Range” section; Updated “Revision History” section —
added “MCO #" column; Updated Logo on title page;
Added “Accuracy at 1600 Degrees F. with thermister
error” column on page 6; Added note about
“Accuracy at 1600 Degrees F. with thermister error”
column; Modified descriptions for #md# and #xd#
TC Offset tags

D Updated the template manager section to include 08-14-08 2067
changes for versions 1.101.0.76 & 1.101.0.80;
Updated realtime screen; Added SDS:FC and SDS:IT
data tags
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